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Welcome to ThermoSpas®

Welcome To ThermoSpas®

Congratulations! You are now the official owner of the finest spa built. All of us at ThermoSpas®
are looking forward to enjoying a relationship with you that will last for many years to come.

As you get to know your spa, you will quickly discover why ThermoSpas® is the fastest growing
spa manufacturer in the country. You have made the right decision in choosing ThermoSpas®.
We’'re betting our reputation on it. A reputation built on the foundation of our many strengths:

Our Credentials

ThermoSpas® has been manufacturing spas since 1983. We strive to stay on the cutting edge

of spa design and maintenance technology. We are constantly looking for ways to bring our
customers the latest features and products designed to enhance the enjoyment and therapeutic
value of our spas. We are a member of the prestigious Association of Pool and Spa Professionals
(APSP). One of the APSP’s primary goals is, “To contribute to the health, safety, and welfare of
the public in the installation, maintenance, and operation of swimming pools and spas.” Our best
credentials come from thousands of satisfied ThermoSpas® owners who write and call us every
day to tell us how happy they are with their spa and what a positive difference it has made in their
lives.

Our Quality

ThermoSpas® emphasis on quality will become crystal clear with each passing day you own your
spa. We make our spas from only the highest quality materials, inside and out. Your spa was
tested to meet our quality assurance standards.

Our Customer Service

Our Customer Care Department is staffed by trained representatives who really care about help-
ing you. They are knowledgeable in every facet of spa maintenance. And they are available to
answer your call Monday - Friday 8:00 am - 6 :00 pm and Saturday 11:00 am - 3:00 pm, Eastern
Time. The Technical Service Department is open Monday - Friday 8:00 am - 5:00 pm and Satur-
day 11:00 am - 3:00 pm, Eastern Time to answer any of your technical questions or needs. You
can also email support@thermospas.com for assistance. A reply will be received within 24 hours.

Your Responsibility To Your Spa

Now that we’ve told you about our priorities in providing you with an exceptional product and
on-going support, we urge you to read through this manual completely. This manual, along with
the information previously supplied in the Welcome Kit will familiarize you with the simple opera-
tion and maintenance of your spa (which will become second nature to you in no time). Most im-
portantly, it will help you keep your spa running smoothly and in tip-top condition for many years
to come.

Have Fun and Enjoy!



Designer Series

How To Contact Us

Email . . ... support@thermospas.com

Office . ..o 800.876.0158

Customer Care Department . ...................... 800.876.0158, option 2

Technical Service Department . .................... 800.876.0158, option 2

Delivery Department . . ........ ... ... .. ......... 866.551.9054

AdAress . . . ... ThermoSpas * 14525 Monte Vista Ave
Chino, CA 91710

Website . . ... ... ... e www. ThermoSpas.com
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1.0 Read and Follow These Important Instructions

When using the electrical equipment, basic safety precautions should always be followed. A
green colored terminal marked G, GR, Ground, Grounding or the Symbol < is located inside
the supply terminal box or compartment. To reduce the risk of electric shock, this terminal must
be connected to the grounding means provided in the electric supply service panel with a con-
tinuous copper wire equivalent in size to the circuit conductors supplying this equipment. At least
two lugs marked “BONDING LUGS” are provided on the external service or on the inside of

the supply terminal box or compartment. To reduce the risk of electric shock, connect the local
common bonding grid in the area of the spa or spa to these terminals with an insulated or bare
copper conductor not smaller than No. 6 AWG. Al field-installed metal components such as rails,
ladders, drains, or other similar hardware within three meters of the spa or spa shall be bonded
to the equipment grounding bus with copper conductors not smaller than No. 6 AWG.

2.0 Important Hot tub Owner Information

Your hot tub is constructed to the highest standards and is capable of providing many years of
trouble-free use. However, because heat retentive materials are utilized to insulate the hot tub
for efficient operation, an uncovered hot tub surface and wall fittings directly exposed to sunlight
and high temperatures for an extended period are subject to permanent damage or discoloration.
Damage caused by exposing the hot tub to this abuse is not covered under warranty. We recom-
mend that you always keep the hot tub full of water when it is exposed to direct sunlight and that
you keep the insulating cover in place at all times when the hot tub is not in use. Read and care-
fully follow the requirements for your hot tub’s support base found in the Section titled, “Choosing
a Location” (page 7). Additionally, water chemistry is extremely important to the longevity

of your hot tub. Failure to properly sanitize the hot tub can lead to algae or bacteria formation.
Overuse of chemical sanitizers can cause damage or discoloration to the hot tub components.
Damage caused by improper chemical use is not covered under warranty.

3.0 FCC Notice

This device complies with part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept
any interference received, including interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B Digital Device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses and can
radiate radio frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause harmful inter-
ference to radio or television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one or more of the following
measures:

Rearrange or relocate the receiving antenna;

Increase the separation between the equipment and receiver;

Connect the equipment into an outlet on a circuit different from the circuit connected;
Consult the dealer or an experienced radio/TV technician for help. (Changes or modifications
not expressly approved by the party responsible for FCC compliance could void the user’s
authority to operate this equipment.)
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4.0 Important Safety Instructions for all Hot tub Owners
READ AND FOLLOW ALL INSTRUCTIONS CAREFULLY!

This hot tub was manufactured to meet the standards and specifications outlined in the “Virginia
Graeme Baker Pool and Spa Safety Act” (VGB Safety Act). When installing and using this hot
tub, basic safety precautions should always be followed, including:

1. /\ DANGER: RISK OF SEVERE INJURY OR DROWNING!

+ Extreme caution must be exercised to prevent unauthorized access by children.

+ To avoid accidents, ensure that children do not use this hot tub unless supervised at all times.
Adult supervision is a critical safety factor in preventing children from drowning.

* Use the straps and clip tie downs to secure the hot tub cover when not in use. This will help
discourage unsupervised children from entering the hot tub. Keep the hot tub cover secure in
high-wind conditions.

* There is no representation that the cover, clip tie-downs, or actual locks will prevent access to
the hot tub.

2. /\ DANGER: RISK OF SEVERE INJURY OR DROWNING!

+ Keep hair, loose articles of clothing or hanging jewelry away from suction fittings, rotating jets
or other moving components to avoid entrapment that could lead to drowning or severe injury.

* Never use the hot tub unless all suction guards, filter, filter lid, or skimmer assembly are
installed to prevent body and/or hair entrapment.

* Never operate or use the hot tub if the filter, filter lid, or skimmer assembly are broken or any
part of the skimmer assembly is missing. Please contact your dealer or nearest service center
for service.

+ The suction fittings and suction covers in this hot tub are sized to match the specific water
flow created by the pump(s). If it is necessary to replace the suction fittings, suction covers
or pump(s), be sure that the flow rates are compatible and are in compliance with the VGB
Safety Act.

* Never replace a suction fitting or suction cover with one rated less than the flow rate marked
on the original suction fitting. Using improper suction fittings or suction covers can create a
body or hair suction entrapment hazard that may lead to drowning or severe injury.
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3. /N DANGER: RISK OF SEVERE INJURY FROM ELECTRIC SHOCK OR DEATH
FROM ELECTROCUTION!

* Install the hot tub at least 5 feet from all metal surfaces. As an alternative, a hot tub may
be installed within 5 feet of metal surfaces if each metal surface is permanently connected
(bonded) by a minimum No. 8 AWG solid copper conductor attached to the wire connector on
the grounding lug, inside the equipment compartment on the equipment box.

» A grounding wire connector is provided on this unit to connect a minimum No. 8 AWG solid
copper conductor between this unit and any metal equipment, metal enclosures of electrical
equipment, metal water pipe, or conduit within 5 feet of the unit.

* Never permit any electrical appliance, such as a light, telephone, radio, television, etc. within
5 feet of a hot tub unless such appliances are built-in by the manufacturer.

* Never bring any electrical appliances into or near the hot tub.

* Never operate any electrical appliances from inside the hot tub or when you are wet.

» The electrical supply for this product must include a suitably rated switch or circuit breaker
to open all ungrounded supply conductors to comply with Section 422-20 of the National
Electrical Code/USA, ANSI/NFPA 70. The disconnecting means must be readily accessible
and visible to the hot tub occupant but installed at least 5 feet, from the hot tub.

+ The electrical circuit supplied for the hot tub must include a suitable ground fault circuit
interrupter (GFCI) as required by NEC Article 680-42.
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: AWARNING: RISK OF SEVERE INJURY OR DEATH!
Extreme caution must be exercised to prevent diving or jumping into the hot tub or slipping
and falling, which could result in unconsciousness, drowning, or serious injury. Remember
that wet surfaces can be very slippery.
Never stand, walk or sit on the top railing of the hot tub.

A WARNING: RISK OF HYPERTHERMIA (OVER-HEATING) CAUSING SEVERE
INJURY, BURNS, WELTS OR DEATH!

Water temperature in excess of 104°F may be injurious to your health.

Refer to Hyperthermia Section for specific causes and symptoms of this condition.

The water in the hot tub should never exceed 104°F. Water temperatures between 100°F and
104°F are considered safe for a healthy adult.

Lower water temperatures are recommended for young children (children are especially
sensitive to hot water) and when hot tub use may exceed 10 minutes.

The Consumer Products Safety Commission/USA has stated that the water temperature in a
hot tub should not exceed 104°F.

Always test the hot tub water temperature before entering the hot tub. The user should
measure the water temperature with an accurate thermometer since the tolerance of water
temperature-regulating devices may vary as much as +/- 5°F.

A WARNING: RISK OF SEVERE INJURY OR DEATH!

Since excessive water temperatures have a high potential for causing fetal damage during
the early months of pregnancy, if pregnant or possibly pregnant, consult your physician before
using a hot tub.

Pregnant or possibly pregnant women should limit hot tub water temperatures to 100°F.
Persons suffering from obesity or a medical history of heart disease, low or high blood
pressure, circulatory system problems, diabetes, infectious diseases or immune deficiency
syndromes should consult a physician before using a hot tub.

If you experience breathing difficulties in association with using or operating your hot tub,
discontinue use and consult your physician.

Persons using medication should consult a physician before using a hot tub since some
medication may induce drowsiness, while other medication may affect heart rate, blood
pressure, and circulation.

Persons suffering from any condition requiring medical treatment, the elderly, or infants should
consult with a physician before using a hot tub.

The use of alcohol, drugs, or medication before or during hot tub use may lead to
unconsciousness with the possibility of drowning.

A WARNING: RISK OF SEVERE INJURY OR DEATH!

Prolonged immersion in a hot tub may be injurious to your health.

Observe a reasonable time limit when using the hot tub. Exposures at higher temperatures
can cause high body temperature (over-heating). Symptoms may include dizziness, nausea,
fainting, drowsiness, and reduced awareness. These effects could possibly result in drowning
or serious injury.

Never use a hot tub immediately following strenuous exercise. Enter and exit the hot tub
slowly. Wet surfaces can be slippery.

AWARNING: TO DECREASE RISK OF INFECTION OR DISEASE!

To reduce the risk of contracting a waterborne illness (e.g. an infection, bacteria or virus) and/
or respiratory ailments, maintain water chemistry within the parameters listed on the inside
cover of this manual and consult with a licensed engineer regarding proper ventilation if in-
stalled indoors or in an enclosed area.
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» People with infectious diseases should not use a hot tub to avoid water contamination, which
could result in spreading infections to others.

» Always shower before and after using your hot tub. Maintain water chemistry in accordance
with manufacturer’s instructions. Failure to do so may result in contracting a waterborne
illness (e.g. an infection, bacteria or virus).

9. &WARNING: In addition to maintenance of filters and water chemistry, proper ventilation
is recommended to reduce the risk of contracting a waterborne iliness (e.g. an infection, bac-
teria or virus) and/or respiratory ailments that could be present in the air or water. Consult a
licensed architect or building contractor to determine your specific needs if installing your hot
tub indoors.

10.CAUTION: TO DECREASE RISK OF PRODUCT DAMAGE.

* Maintain water chemistry in accordance with manufacturer’s instructions.

* Proper chemical maintenance of hot tub water is necessary to maintain safe water and
prevent possible damage to hot tub components.

1. &WARNING: RISK OF SEVERE INJURY OR DEATH! The appliance is not intended
for use by persons (including children) with reduced physical, sensory or mental capabilities,
or lack of experience or knowledge, unless they have been given supervision or instruction
concerning use of the appliance by a person responsible for their safety.

12.NOTE: This hot tub is not intended nor designed to be used in a commercial or public appli-
cation. The hot tub buyer shall determine whether there are any code restrictions on the use
or installation of this hot tub since local code requirements vary from one locality to another.
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Hot Tub Safety Literature
To ensure you have a safe and enjoyable hot tub experience, learn all you can about hot
tub safety and emergency procedures.

The Pool & Hot Tub Alliance has a great source of safety literature.
* Go to http://phta.org
» Conduct your own search on the internet
» Write to the following address:
Pool & Hot Tub Alliance
2111 Eisenhower Avenue
Alexandria VA 22314
703.838.0083

FOR CALIFORNIA RESIDENTS ONLY

A WARNING: Drilling, sawing, sanding or machining wood products FOR CALIFORNIA RESIDENTS ONLY

can expose you to wood dust, a substance known to the State of
California to cause cancer. Avoid inhaling wood dust or use a dust
mask or other safeguards for personal protection. For more infor-
mation go to www.p65Warnings.ca.gov/wood

A WARNING: Cancer and Reproductive Harm
www.p65Warnings.ca.gov
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4.1 Entrapment Risk

The Consumer Products Safety Commission/USA has reported that users of pools and spas
have become entrapped (stuck) to drain and/or suction fittings causing death, drowning, or seri-
ous injury (see diagram below). This spa was manufactured to meet the standards and specifica-
tions outlined in the “Virginia Graeme Baker Pool and Spa Safety Act” (VGB Safety Act). Entrap-
ment risk can be minimized if proper precautions are taken.

DANGER: RISK OF PERSONAL INJURY OR DEATH!
Never operate the hot tub if a suction fitting, suction cover, filter, filter lid or skimmer
assembly are broken, damaged or missing.

Skimmer Cover

Skimmer location and ap-
pearance may vary from
one shown

Suction Covers

Note: Suction covers must be replaced every 7 years.

/\ DANGER: RISK OF PERSONAL INJURY OR DEATH!
Never operate the spa if a suction fitting, suction cover, filter, filter lid or skimmer assembly are
broken, damaged or missing.

/\ DANGER: RISK OF SEVERE INJURY OR DROWNING!

Hair entrapment: May occur if hair is entangled, knotted or snagged in a drain suction or skim-

mer assembly. This has been reported in persons who when submerge themselves underwater,

allowing hair to come close and/or within the reach of the suction fittings, suction covers or skim-

mer assembly.

+ Keep hair away from suction fittings, suction covers, filter, filter lid or skimmer assembly.

» Children are at risk for hair entrapment if swimming under water.

* Never allow children to play or get near the suction fittings, suction covers, filter, filter lid or
skimmer assembly.

/\ DANGER: RISK OF SEVERE INJURY OR DROWNING!

Limb entrapment: May occur when a limb becomes entrapped, inserted or sucked into a suction

or outlet opening.

+ Always keep suction fittings, suction covers, filter, filter lid or skimmer assembly in place when
operating to avoid limb entrapment.

* Never allow children to play or get near the suction fittings, suction covers, filter, filter lid or
skimmer assembly.
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/\ DANGER: RISK OF SEVERE INJURY OR DROWNING!

Body entrapment: May occur when part of the torso becomes entrapped, inserted or sucked

into a suction or outlet opening.

* Never allow children to play or get near the suction fittings, suction covers, filter, filter lid or
skimmer assembly.

/\ DANGER: RISK OF SEVERE INJURY OR DROWNING!

Evisceration (disembowelment) entrapment: May occur when the buttocks becomes en-

trapped, inserted or sucked into a suction or outlet opening.

* Never sit on suction fittings, suction covers, filter, filter lid or skimmer assembly.

* Never allow children to play or get near the suction fittings, suction covers, filter, filter lid or
skimmer assembly.

/\ DANGER: RISK OF SEVERE INJURY OR DROWNING!

Mechanical entrapment: May occur when jewelry, swimsuit, or hair accessories become entan-

gled, knotted or snagged in a drain suction or skimmer assembly.

* Never allow your jewelry, swimsuit, or hair accessories to come close to the suction fittings,
suction covers or skimmer assembly.

» Never allow children to play or get near the suction fittings, suction covers, filter, filter lid or
skimmer assembly.

4.2 Be Aware of the Risk of Fatal Hyperthermia

The use of alcohol, drugs, or medications can greatly increase the risk of fatal hyperthermia.
Hyperthermia occurs when the internal body temperature reaches a level several degrees above
normal body temperature (98.6°F). The symptoms of hyperthermia include dizziness, fainting,
drowsiness, lethargy, and an increase in the body’s internal temperature.

The effects of hyperthermia include:

* Failure to perceive heat

* Physical inability to exit the spa

* Unconsciousness and danger of drowning

* Failure to recognize impending hazard

+ Failure to recognize the need to exit the spa
» Fetal damage in pregnant women

4.3 PRECAUTIONS-Important Chemical Safety

Do not use this device with bromide products.

4.4 PRECAUTIONS FOR USE OF PRODUCTS CONTAINING SODIUM BROMIDE

* Do not use any Product containing Sodium Bromide with an electrolysis device (for example,
a chlorine generator).

* Do not use any Product containing Sodium Bromide with ozonation.

* Do not use any Product containing Sodium Bromide with ultraviolet (UV).
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5.0 Choosing A Location

IMPORTANT: Because of the combined weight of the spa, water and users, it is extremely
important that the base upon which the spa rests be smooth, flat, level and capable of uniformly
supporting this weight, without shifting or settling, for the entire time the spa is in place. If the spa
is placed on a surface which does not meet these requirements, damage to the skirt and/or the
spa shell may result. Damage caused by improper support is not covered under warranty. It is the
responsibility of the spa owner to assure the integrity of the support over time. We recommend

a poured, reinforced concrete slab with a minimum thickness of 4 inches. Wood decking is also
acceptable provided it is constructed so that it meets the requirements outlined above.

Note: This spa is not intended nor designed to be used in a commercial or public application.
Use of this spa in public or commercial application will VOID the warranty. The spa buyer shall
determine whether there are any code restrictions on the use or installation of this spa since local
code requirements vary from one locality to another.

Site preparation, alterations to home owner’s property and permits (if any) are the sole responsi-
bility of the owner. ThermoSpas® spas are not intended for commercial applications.

cifically tied into main structural support, consult a professional Structural Engineer with

é WARNING: For spas that are to rest on balconies, roofs or other platforms not spe-
experience in this type of application.

WARNING: Proper drainage is required. The installation must not allow the spa
equipment bay to become flooded or wetted (by external water). It is your responsibility,
and the responsibility of any installation contractor you hire, to make sure that all ap-
plicable codes and/or local construction requirements are met. If in doubt, refer to the
building authority responsible for approving the proposed installation site.

The spa must be installed in such a manner as to provide drainage away from it. Placing the spa
in a depression without provisions for proper drainage could allow rain, overflow, leaks from spa
plumbing, and other casual water to flood the equipment and create a wet condition in which it
would sit in. For spas which will be installed below grade or recessed into a floor or deck, install
so as to permit access to the equipment, either from above or below, for servicing. Make certain
that there are no obstructions, which would prevent removal of all side cabinet side panels and
access to the jet components, especially on the side with the equipment bay.

CAUTION: If the spa is indoors or located in an enclosed area, proper ventilation should
be discussed with an Engineer or authority competent enough to understand the nec-
essary provisions needed to vent moist or heated air and air associated with chemical

odors outdoors. When the spa is in use considerable amounts of moisture will

escape potentially causing mold and mildew. This can cause health risk. Over time,
this can damage certain surfaces, surroundings, and equipment.

5.1 Outdoor Location

In selecting the ideal outdoor location for your spa, we suggest that you take into consideration

the following:

« The proximity to changing area and shelter (especially in regions subject to cold weather).

« The pathway to and from your spa (this should be free of debris so that dirt and leaves are not
easily tracked into the spa).

* The closeness to trees and shrubbery (remember that leaves and birds could create extra
work in keeping the spa clean).
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A sheltered environment (less wind and weather exposure can result in lowered operation and
maintenance costs).

The overall enhancement of your environment. It is preferable not to place the spa under an
unguttered roof overhang since run-off water will shorten the life expectancy of the spa cover.
For spas that are to rest on balconies, roofs or other platforms not specifically tied into main
structural support, consult a professional Structural Engineer with experience in this type of
application.

In the unlikely event that you should ever need to access or gain entry to any portion of the
spa for servicing, it is highly recommended that you plan your outdoor installation to provide
full access to the entire spa. Please take this into consideration when placing the spa in a
deck or enclosed by a surrounding.

Consider locating your spa away from any reflective surface or glass to prevent any damage
to the synthetic skirt.

Do not shim the spa. To ensure proper support the spa must sit flat on the intended
foundation.

Floor load capacity must be a minimum of 100 Ibs. per square foot and must meet your local
building codes. Swim spas and spas over 39" in depth require higher load capacity. Reference
page 58 for information.

Spa can not be installed on asphalt, laid in dead sand or on stone dust.

Spa can not be placed directly on a gravel or lawn surface.

Delivery crew is not equipped to level and/or repair spa sites.

Most spa servicing is performed on the spa equipment that is located behind the side cabinet
panels of the spa. It is important to install the spa to allow easy access to the spa equipment.
We recommend an 18" minimum clearance around all sides of the spa to avoid additional
service charges. Providing service access is the responsibility of the owner.

A WARNING: Do not rest your spa directly on top of a power line. Electrical shock or
power failure may result. The power line to the spa should be routed through the side wall by
drilling a hole.

5.2 Indoor Location
For indoor installations many factors need to be considered before installing a spa indoors:

lation is recommended to reduce the risk of contracting a waterborne illness (e.g. an

f WARNING: In addition to maintenance of filters and water chemistry, proper venti-

infection, bacteria or virus) and/or respiratory ailments that could be present in the air
or water. Consult a licensed architect or building contractor to determine your specific
needs if installing your spa indoors.

PROPER FOUNDATION: Consult a Structural Engineer when considering a foundation
that will adequately support the spa the entire time it is in place. Proper support is
critical especially if the spa is to rest on a second story or higher. For spas that are to rest on
balconies, roofs or other platforms not specifically tied into the main structural support, you
should consult a professional Structural Engineer with experience in this type of application.

PROPER DRAINAGE: It is extremely important to have in place measures to sufficientl
handle excessive water spillage. Be sure the flooring in which the spa rests on has
adequate drainage and can handle draining of the entire contents of the spa. Be sure to make
provisions for ceilings or any other structures that may be below the spas installation. Areas
around your spa can become wet or moist so all flooring and subsequent furniture, walls and
adjacent structures should be able to withstand or resist water and moisture.
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PROPER VENTILATION: Proper ventilation should be discussed with an Engineer or

authority competent enough to understand the necessary provisions needed to vent
moist or heated air and air associated with chemical odors outdoors. \When the spa is in

use considerable amounts of moisture will escape potentially causing mold and mildew, over
time this can damage certain surfaces and or surroundings.

SUFFICIENT ACCESS: In the unlikely event that you should ever need to access or gain
entry to any portion of the spa for servicing, it is highly recommended that you plan your
indoor installation to provide full access to the entire spa.

WARRANTY: Damage caused by not following these guidelines or any improper installation
not in accordance with local codes or authorities is not covered under the spas warranty.
Please consult your local state or city building ordinances.

DO NOT SHIM THE SPA: To ensure proper support the spa must sit flat on the intended
foundation.

Spas installed indoors must be placed on a non-porous surface with a drain.

Do not put the spa on a carpet or hardwood floors due to possible splash out from the tub.
Water will accumulate around the spa, so flooring materials must provide a good grip when
wet. Water damage to the home owner’s property from splashing or leaks are at the home
owner’s risk. This is not covered under any ThermoSpas® warranty.

Adequate ventilation must be provided in order to allow for chemical fumes to escape. Take
into consideration that these fumes could enter other indoor areas.

When the spa is installed indoors or outdoors, adequate room must be provided to allow the
cover and lifter to operate and function properly. Depending of the lifter used, up to 50% of
the cover is exposed. There should be sufficient room accounted for the spa height plus cover
lifter measurement, Figure 1.

Consult your local state or city building ordinances to ensure installation is in accordance
with local codes. Any damage caused if you do not follow these guidelines voids the spa’s
warranty.

Most spa servicing is performed on the spa equipment that is located behind the side cabinet
panels of the spa. It is important to install the spa to allow easy access to the spa equipment.
We recommend an 18" minimum clearance around all sides of the spa to avoid additional
service charges. Providing service access is the responsibility of the owner.

Figure 1

(Cover lifter and
spa can vary from
the one shown)
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Designer Series

6.0 Electrical Set Up A DANGER

RISK OF SHOCK OR

Before beginning the wiring process turn off the circuit breaker so that no ELECTROCUTION!
power is connected to the controller. ThermoSpas® recommends all spa wiring to

be done by a licensed electrician. Improper wiring may void your warranty. Incorrect zlllll

or incomplete wiring will very likely create a dangerous hazard. Performing a conver- %«
sion or any other modification to the original hardware or installation configuration

mandates that the owner assumes full responsibility for assuring that the resulting Turn power off
system complies with all applicable national, state, and local wiring codes and ordi- [t

performed by a quali-

nances for the location of the unit. Be aware that there are major differences in wiring [z e
codes if this unit is to be installed at any location other than a private residence.

The Safe Electrical Hook-up of Your Spa

» The electrical installation of your spa must be done by a qualified electrician in accordance
with the National Electrical Code (NEC), and all local codes effective at the time of installation.

* Your spa must be installed on a dedicated electrical circuit. No other appliances or electrical
equipment may be used on this circuit.

A WARNING: If your spa is not installed in accordance with the NEC, it may create a dan-
gerous safety hazard. Improper electrical installation may also damage the inner workings of a
spa and void your warranty.

A WARNING: If your electrician is not absolutely sure how to correctly connect your system,
call the ThermoSpas® Technical Service Department at 800.876.0158, option 2. Mistakes may

be costly and will void your equipment warranty. Before beginning the wiring process turn off the
circuit breaker so that no power is connected to the controller. ThermoSpas® recommends all spa
wiring to be done by a licensed electrician. Improper wiring may void your warranty.

Electrical Service Requirements

Before wiring for a spa, one of the first considerations is whether or not your main service or
sub-panel feeding your spa has the capacity to provide sufficient power to your spa. A licensed
electrician will be able to perform a load calculation to determine this.

Select the inlet you want to use, drill a hole large enough for the wires on the skirt panel and
then feed the power cable through to the control box. To allow access you will have to trim/cut
the ThermoFoil blanket under the skirt. For access from underneath the spa, please contact the
Service Department for help (800.876.0158 or support@thermospas.com).

Note: You can use any of the four corners of the spa to drill a hole for the power cable. The pan-
els on most models are not predrilled. Manhattan Il models are predrilled 18” from the front left
corner.

The electrical requirements for your spa are found on the Electrical Guide Sheet contained in the
Welcome Kit for your specific model. It is very important to review your electrical requirements
before starting installation.

10
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Removing the cabinet panels

1.  Grab one of the corner panels, from the bottom, where it f
touches the bottom pan. Then gently pull the panel forward
to unsnap it from the holding clip then pull down to remove.
Place the panel in a safe location to prevent from damaging it.
Repeat the steps to remove the other corner panel.

2. Grab the bottom of the panel and slightly lift to release it from
the top mount. Tilt the panel and pull down to remove. Before
completely removing the panel, take hold of the indicator light Nt/
wire and gently pull on it to slide the light from the housing.
Place the panel in a safe location to prevent from damaging it. U= U

3. Carefully fold back the ThermoFoil and remove the foam insert ‘
to expose the controller.

4. Remove screws from the controller to expose the wiring
terminal.

5. To reinstall the panel just follow the steps above in reverse
order.
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Electrical Service Considerations

The Electrical Service determines how many pumps can run in conjunction with the heater. If the
dedicated GFCI circuit was installed with a smaller breaker than the recommended size (typically
60 amps), your heater will automatically shut off to avoid tripping your circuit breaker if too many
pumps are activated (including the blower). Heating will automatically turn back on after pumps
have been shut off. The heater will also automatically shut off on larger spas when 3 or more
pumps (including the blower) are turned on. All of this may occur even though the circulation
pump (if equipped) continues to run — when the heater is on, progressing bars will be indicated
from the bottom to the top of the heater icon.

A WARNING: Wiring to your spa must be COPPER ONLY! Note that the wiring from a main
panel to a sub-panel for the spa must be copper and the sub-panel is rated for copper (CU).

The length of the wiring from the panel or feed to your spa also has to be determined. If the total
run exceeds 75 feet, the wire size must be increased by one wire size to adjust for the corre-
sponding voltage drop. To make future service work easier we recommend leaving at least 6'

of slack in the main electrical wire which may be coiled inside the cabinet. Ground Fault Circuit
Interrupt (GFCI) Requirements: All spa electrical circuits must be GFCI protected on a dedicated
circuit.

It is common practice for electrical service for a spa to be supplied by a regular two-pole breaker
at the rated amperage at the main panel, and the disconnecting means (NEC Article 100) is usu-
ally a 125-amp sub-panel with the required GFCI breaker(s) mounted inside. The GFCI breaker
becomes the required disconnecting means. These sub-panels sometimes will not have a ground
bar included and it must be purchased separately. The ground bar is a small metal bar with holes
provided for ground wires and screws to secure the wires to the ground bar. This ground bar is
NOT to be bonded or connected to the neutral bar, and the neutral bar must be isolated from any
grounding source. The GFCI pigtail in this instance is connected into the neutral bar—not the
ground bar.

11
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Electrical Requirements

« All ThermoSpas® 2022 Designer series units require 6/4 gauge copper stranded wire & a 50
amp G.F.C.|. breaker, dedicated power supply .

* GFCI breaker should comply to national electrical codes. Min 5’ distance from spa.

« ThermoSpas® does not provide or supply any wiring from the main panel to the Spa power
supply terminals. It is best to have all of the wiring completed after the Spa is delivered.
Delivery teams are not licensed to wire any installations. This must be done by your licensed
electrician. Spa MUST be wired as shown in the below diagrams.

* Your electrical connection can enter the Spa from any of the 4 corners and travel through
the unit to the control terminal block to make the wiring less visible. Controls are generally
located under the keypad side of the Spa. See the engineering drawing of your specific unit.
ThermoSpas® does not recommend bringing wiring up from underneath the spa.

* Local electrical and building codes may vary. Always check your local codes to make sure
your installation is in compliance.

+ Contact 800-876-0158 or support@thermospas.com with any questions.

Ground Fault Circuit Interrupt (GFCI) Wiring Diagram
Spa Pack
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7.0 Spa Start Up

Please read through all steps before beginning. This section explains the necessary procedures
required to start up your spa. Familiarize yourself with this procedure prior to beginning the pro-
cess. Use this procedure as a guideline.

» Make sure you have any instructions along with the Welcome Kit and Chemical Starter Kit
prior to filling your spa.

» If your water is acidic, hard, or has a high mineral content it is recommended to contact one of
our trained Customer Care Representatives after filling the spa for water treatment guidance.

» Failure to follow these start-up instructions for your spa and observe the recommended
maintenance time periods may result in pump damage or require draining and refilling the spa.
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Chemical balancing may take 3-7 days to settle in, based on the following variables.:

Incoming water temperature and water pressure (fill rate)
Size and type of spa

Water characteristics (hardness, mineral content)
Desired final water temperature

Ambient conditions

aRrwN =

Inspect and Filling you spa

Once your spa is in its final location it is time to inspect it to ensure it is ready to be filled. Gently
remove all packing and crating materials from the spa.

Step 1: Remove the panels/insulation of the spa so you can see the interior.

Step 2: Remove filters, the accessory bag and the spa chemical starter kit located inside the
spa shell.

Step 3: Wipe sp 6P Wi MUS A AVED bnd d ERMINALI GECIBREAMRERe surface with any

particles that may have fallen into the tub.

Step 4: Make sure the “T” valves on each water pump are open by pulling them up as far as
they will go and locking them in the open position, page 49.

Step 5: Make sure all water pump and heater unions are tight, page 49.

Step 6: Make sure the drain valve is closed, page 49.

Step 7: Install the filter(s).

Step 8: In certain situations, if your water is extremely “hard,” it is preferable to fill half-way with
hard water and the rest of the way with softened water. Water that is too soft can be

corrosive to metal components.

Step 9: Let the water run out of your garden hose for several minutes before filling the spa. This
will flush out stagnant water in the line that may cause bacteria.

13
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Step 10:Begin filling your spa up to 1” below the pillows. The actual water level may vary
depending on the bather load. When there are no bathers in the spa, the water must
be high enough to prevent pump surge and low enough that when the recommended
number of bathers are in the tub that the water is not overflowing out of the spa. The
recommended water level is half way up the filter area with no bathers. While spa is
filling periodically check underneath to be sure unions are tight and not leaking.
Note: Unions are located on both the spa’s water pump(s) and heater. It is imperative that they
are checked and tightened before filling the spa. Although every spa is thoroughly tested twice in
our factory during final inspection, some connections may loosen during transport from the
factory to your home.

Heat Water
Step 1: Set desired temperature by pressing the Warm ( @ ) or Cool ( @ ) button.

Step 2: Install insulated cover, close it over spa, and secure it with the lock down straps.

Step 3: Allow between 5 and 24 hours for the water to reach the desired temperature. A 240-volt
service will raise it approximately 4° to 8°F per hour.

DANGER: RISK OF PERSONAL INJURY.
Check water temperature carefully before entering hot tub! Excessive water tempera-
ture can cause burns, welts and body temperature to rise, hyperthermia (over-heating).

Prep Water: Maintaining Correct Water Chemistry and Safety

Improper use of spa chemicals may be dangerous and could damage your spa and its cover.
Since this damage is not covered by your warranty; it is extremely important to take precautions
when using these products. Only use chemicals and cleaning agents designed for spas. Damage
resulting from the use of non-recommended chemicals and/or cleaning agents is not covered
under the warranty. Following the procedures in this guide will make the maintenance and care of
your spa simple and economical.

Avoid using any biguanide or copper-based algaecide with your spa. Use of these products is not
recommended by ThermoSpas® and may void your warranty.

CAUTION: RISK OF PERSONAL INJURY OR SPA DAMAGE!

A Never add chlorine tablets (trichlor) or acid to your hot tub for any reason! Do NOT use
swimming pool chemicals. These chemicals may damage components within your hot
tub, burn or irritate your skin, create a rash, and void the manufacturer warranty for your
spa. Use only products designed specifically for spa applications.

14
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Proper Handling of Chemicals
1. Keep all chemicals out of reach of children.

2. Always keep lids on chemicals when not in use and store them in a cool, dry location away
from direct sunlight.

3. Do not store chemicals within the interior of the spa’s cabinet.
4. Do not interchange caps or measuring scoops for different types of chemicals.
5. Do not smoke around chemicals. Some can emit highly flammable fumes.

6. In case of contact or if a chemical is swallowed, call a doctor or local Poison Control Center.
If a doctor is required, bring the chemical container with you so the doctor can determine the
appropriate treatment.
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7. Never mix chemicals or chemical solutions directly with each other.
8. Always add chemicals to water when mixing them. Never add water to chemicals.

9. When in doubt, call Customer Care at 800-876-0158.

WARNING: RISK OF POISONING OR DEATH.

A Never leave chemicals opened and accessible to anyone. Use chemicals according to
the vendors instructions. Always store chemicals in a safe and/or locked location. Keep
away from and out of reach of children.

Proper Procedure for Adding Chemicals

Proper water chemistry is essential to the safety of the user as well to the life of the spa compo-
nents. Improper water chemistry may cause skin irritation or facilitate the transmittal of disease.
Proper water chemistry is the sole responsibility of the spa owner. The costs incurred from injury
or damage resulting from improper water chemistry are not covered under the ThermoSpas®, Inc.
warranty.

1. Turn on jets pump(s) for one minute to move water when adding chemicals to ensure proper
mixing and leave your spa cover open until the sanitizer level becomes stable to protect
pillows and plastic knobs from chemical attack.

2. Do not add chemicals through the skimmer.

3. Only add one chemical at a time. Unless otherwise specified always wait after adding
chemicals to your spa before adding more chemicals.

Note: Depending on the metals or mineral content of your tap water, one of the chemicals in

the treatment may react to cause a discoloration or formation of a precipitate. In this event you

should not have to drain your spa. There are treatments to solve this problem. If you have any

questions contact Customer Care.

WARNING: BECAUSE OF THE RISK OF INHALING CHEMICAL VAPORS.

* To decrease the risk of injury, drowning or entrapment, never leave your hot tub un-
attended for any reason while the cover is open and accessible, especially to small
children and animals!

* Precautions should be taken to minimize your exposure to chemical vapors (that
could cause lung, brain, or skin damage).

15
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8.0 Spa Diagrams

The illustrations below show a typical configuration for each spa with multiple jet styles, a bub-
bling system, an ozone system upgrade and an independent circulation/filtration pump system.
If your spa was not ordered with any of these features, the system components will not

be found in your spa. Top trim levels shown. Lower trim levels will not include some features.
These illustrations are designed to help you identify key components.
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KEY:

1. EasyTouch Control 13. Whirlpool Jet
2. Wave Lounge / Auxiliary Control 14.Pulsator Jet

3. Pillow with Pillowfall 15.Laser Jet

4. Jet Air Boots Controls 16. Therapy Jet

5. Pillowfall Control Valve 17.Cyclone Jet

6. Grab Bar 18. Swirl Jet

7. Throttle Control Diverter Valve 19.Cyclone XL Jet
8. Suction Cover 20.Footwell Light
9. Filtration Return 21.0zone Return
10.Filter Weir 22.Circulation Pump Return
11. Filter Lid 23.Bullet lighting

12. Air injector

Manhattan II™ Diamond Wave

Example Diagram. Features and locations subject to change without notice.
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Park Avenue II™ Diamond Wave

<

® ol &
@0e

Example Diagrams. Features and locations subject to change without notice.
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Concord II™ Diamond
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Example Diagram. Features and locations subject to change without notice.

18



Designer Series

9.0 Equipment Diagram

The illustration below shows a typical equipment compartment. If your spa was not ordered with
any of these features, the system components will not be found in your spa. These illustrations
are designed to help you identify key components. Use the legend to locate a particular
component’s page number to see more details.

Drain Hose
located in top
left corner.

ThermOzone™
Equipment

Controller
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Heater Pump 1

Ozone Generator

Pump 3
Part Page |Part Page
Air Pump (Blower) 49 Mixing Vessel (ThermOzone ™) 44
Circulation/Filtration Pump 49 Ozone Generator 44
De-gas Vessel (ThermOzone™) (44 Controller and Heater 50
Light Controller 25 Water Pump 49

Example equipment bay illustration. Equipment locations may vary. Not all spa models or trim levels will
have all equipment shown.
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10.0 Topside Control Panel (Gold, Diamond &

Diamond Wave Models)
10.1 Start-up Sequence

During the start-up sequence, the initializing screen will appear showing the software information,
then the hot tub will display the Home Menu. A blow-out cycle will run between 12pm and 2pm.

10.2 EasyTouch Control Panel

Your ThermoSpas® hot tub is equipped with a state-of-the-art LCD touch screen control panel.
Access to all menus can be achieved by using the touch screen. Programming features can be
easily programmed with our user-friendly design. With the ease of use, there will more time to
enjoy the benefits of your hot tub.

A. Home Menu

The Home Menu provides access to hot tub functions and programming. Operation is made easy
by the interactive touch-screen control panel. If there is no activity for 2 minutes, the display will
time-out into a sleep mode. To reactivate the display, just tap and briefly hold the display then
drag the ThermoSpas® logo into the box.

NOTE: When a feature is on, the icon will be animated.

Diamond & Diamond Wave Models)

(Gold,

Drag icon to unlock
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TherruSpas

@@ = Temperature Control: Allows you to adjust the set temperature of the hot tub:
* Increase the temperature by tapping @ in 1° increments.
« Decrease the temperature by tapping (¥) in 1° increments.
Note: The temperature range for the hot tub is 59 to 104°F (15 to 40°C). When the hot tub is
heating a message will appear on the Home Menu.

= Light Button: Tap once to activate the lights.

Jet Button: Tap one of the Jets pumps button to activate, page 22.

= Blower Button: Tap button to activate the blower ON and OFF.

#®@®0

= Lighting Effects Button: Tap to access the menu to operate the various
lighting options, page 25.

20
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‘PIOD)

Home Button: Tap any time to return to the Home Menu.

= Settings Button: Tap to access the programming and setting menus, page 26.

Invert Button: Tap to enter the invert selection menu.

= Contrast Button: Tap to enter the contrast selection menu.

= Sleep Button: Tap to enter a sleep mode. A message is displayed prompting
you to tap the icon to continue.

B. Status Notifications

The status notifications display is at the top of the Home Screen menu. When certain compo-
nents, features or programs are on, their icons are represented there. No icons will display if a
feature is not installed.

(S|2POIN PABAN pPuowiBI(] X puowelid

® = Lighting System Icon: Will displayed to show that a lighting system is
connected, page 25.
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A = Error Indicator Icon: Displays when there is error message that needs to
be addressed. The icon will also appear under the temperature reading as a
reminder, page 51.

L~ =  Wi-Fi Icon: Displays when there is a network connection to the spa. SmartTub®_
Equipped Models only.

6:45am = Time Indicator: The time will always be shown when the Home Menu is displayed.
The appearance will vary depending on whether the clock is set to a 12-Hour or
24-Hour configuration, page 30. The default setting is 12-Hour.

Note: The time will automatically adjust for daylight saving time.

Exterior Status Light: An exterior status light on the outer spa cabinet indicates the spa’s
current operating status at a glance, page 51.
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Designer Series
10.3 Control Valves

Several components have dedicated valves that give you more control over their function.
The operation of each valve is described below.

1. Jet Air Boost Control Valve o
Controls the water to air ratio to vary the intensity of the jet. ON/OFF rocker
button. Jet Air Boost
Control

2. Pillowfall Control Valve
Controls the water intensity flow to the pillowfall. Turn the valve clockwise to _
decrease the intensity; counterclockwise to increase the intensity. ‘

3. Throttle Control Diverter Valve Pillowfall Control
Rotate valve to divert flow to specific sections of the spa.

Throttle Diverter Control

10.4 Jets

Therapy Jets

Popular spa jets with powerful directional streams. These are easily
controllable to give you just the right amount of massage. Turn the outer ring to
open or close the jet to control the power. The nozzle can be adjusted by simply
touching it and pointing it to the desired location on your body.

Swirl Jets

Pamper you with a swirling massage. The nozzle design swirls the water around
in a circular pattern, giving you an overall massage in a wide area. Power from
the jet is also controlled by turning the outer ring to open or close the jet stream.

Cyclone Jets
Air and water move in circles evoking the sensation of thumbs pressing and
deliberate pulsing action that rhythmically loosens muscles and eliminates stress. f

NOTE: The Therapy Jet, Swirl Jet and Cyclone Jet are interchangeable and Cyclone Jet

allow you to customize the feel of your water therapy. To remove the Jet from
the Jet Body, turn the Jet counter-clockwise to unthread it from the jetback.
Thread in the new jet until you feel a resistance.
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Whirlpool Jets
Large round jets that are particularly good for those with special therapy needs.

absolute must for those in need of massage therapy.

Laser Jets

Pinpoint and soothe individual joints. These are smaller than the rest of

the jets, but they are very powerful. When clustered together and positioned
properly, you will get a one-of-a-kind massage.
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Pulsator Jets

Gently knead tired muscles. The same size as the Laser Jet, but includes the
unique ability to pulsate. Imagine the feeling of the magical fingers of a master
masseuse.

Cyclone XL Jets

Powerful spinning jet provide a unique and deliberate kneading action that is
both therapeutic and soothing. They can cover a large area at a time and feel
like a steady pulse against large portions of your body.

Cyclone
NOTE: The Laser Jet and Pulsator Jet are interchangeable and allow you to XE Jet
customize the feel of your water therapy. To remove the Jet from the Jet Body,
turn the Jet counter-clockwise to unthread it from the jetback. Thread in the
new jet until you feel a resistance.

Pillowfall

Gives an unbeatable neck massage and include a control valve to adjust the

intensity. This is a favorite feature among many ThermoSpas® customers.

Nothing compares to a nice neck massage, so the Pillowfall was created to _
do just that. No need to put your head under water — just sit back in your ther-

apy seat, put your head on the pillow, push the button and you receive a nice

flow of warm water across the back of your neck.
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Diamond & Diamond Wave Models)

(Gold,

Designer Series

11.0 Operating Instructions (Gold, Diamond &

Diamond Wave Models)
11.1 EasyTouch Control Panel

Your ThermoSpas® hot tub is equipped with a EasyTouch Control panel that offers an advanced

high resolution interactive touch screen. Many of the hot tub functions can be access through the
Home Menu.

Spa = 8:01 am

%3

Pump1 Pump2 Pump3

@
°Fo®

11.2 Activating the Jets Pumps

From the Home Menu tap @ to turn the Jets pumps on. This menu also operates the blower. Any
time a pump or the blower has been manually turned on, it will automatically turn off after approx-
imately 20 minutes. If at this time you desire more jet operation you may simply turn the pump(s)

back on.

Pump 1

Pump 2

Pump 3

Jet Pump 1 Button ::

JETSICON JETS ICON
Jet Pump 2 Button
WHEN OFF  WHEN ON

Jet Pump 3 Button (if equipped)

&)

Blower Button (if equipped)

1. Tap the Jet 1 button to turn the pump #1 on and off.
2. Tap the Jet 2 button to turn the pump #2 on and off.
3. Tap the Jet 3 button to turn the pump #3 on and off.
4. Tap the Blower button to turn the blower on and off.
Note: When a jets pump is on, the jets icon will spin.
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11.3 Lights Menu

From the Home Menu slide the left wheel until the light icon ( @ ) is selected to enter the Light
submenus. Then screen will display the Light Submenu. The default setting when you enter the
submenu is zone 2. From this menu, you can control the interior lighting and blending effect.
When you slide the right wheel, the lights will turn on, either in zone 1, zone 2 or zone 3

(if equipped).

Note: The lights automatically turn off after 2 hours. They can be reactivated if needed.

‘PIOD)

8:01 am

Pump1 Pump2 Pump3

(SIPPOIN PABAA puoweliq ¥ puoweiq

= Light Button: Tap once to activate all lights.

is be illuminated.
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= Zone 2 Button: Tap to turn ON all internal lights. When feature is ON the light
bulb is be illuminated.

= Zone 3 Button: Tap to turn ON the external lights. When feature is ON the light
bulb is be illuminated. The only light color option is white. Feature only available
with Exterior Lighting package.

‘ = Zone 1 Button: Tap to turn ON the main light. When feature is ON the light bulb

= Synchronization/De-synchronization Button: Tap to either synchronize or
desynchronize the main interior and all around interior lights. They can be
independently controlled. When the synchronizing feature is on the icon be
illuminated in yellow. Does not affect exterior lighting (if equipped).

Blending Button: Tap to turn ON the blending modes. Once to turn ON the

slow blending mode, tap a second time to turn ON the fast blending mode, tap a

third time to turn OFF.

Note: When the blending mode is turned OFF the lights will default to the last solid color used.

. = Slow Blending Button: Turns on when the you tap the blending mode. The
lights will blend in a slow and calm mode.

- = Fast Blending Button: Tap the blending mode again to blend the lights in a
quick blending mode.

, = Color Selection Wheel: Tap a color from the wheel to turn it ON.

0 —

e = Intensity Slider: Slide from side to side to increase and decrease the
intensity level. Slide to the left to turn OFF.
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12.0 Programming Instructions (Gold, Diamond &
Diamond Wave Models)

Your hot tub is equipped with setting menus that allow you to program and activate different com-
ponents of the hot tub. With our Easy Touch Control programming your hot tub has never been
easier. In the sections that follow, we will guide you through the process of programming the hot
tub to fit your personal comfort. Slide the left wheel to the settings icon ( @ ) to enter the Set-
tings Menu. Slide the right wheel to select one of the settings options.

8:01 am Settings Settings

Pump1 Pump2 Pump3

ts water care =  Water Care: Provides access to the water care programming, page 27. You
can also access the menu by tapping .

£ Maintenance Maintenance: Provides access to the reminders and error log menu, page

29. You can also access the menu by tapping (5.

[%® Date & Time

Date and Time: Provides access to the date and time programming, page
30. You can also access the menu by tapping .

O Keypad = Keypad: Provides access to the units, contrast, display view and language
settings, page 30. You can also access the menu by tapping .

/ eearicaiconfig. = Electrical Configuration: Provides access to the electrical programming,

page 31. This menu is to be accessed by a qualified and authorized

= Wi-Fi =  Wi-Fi: Provides access to the Wi-Fi settings, page 31. SmartTub® Equipped
Models only.

-« Miscellaneous = Miscellaneous: Lets you program a “Warm weather” setting that allows filtering
to occur even though the water temperature is high, page 33. You can also
access the menu by tapping Q

@ About = About: Displays software and system information, page 23. You can also

access the menu by tapping .
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12.1 Water Care

Your hot tub is equipped with 5 programmable modes. Each of the modes are described below.

Note: Economy mode will not allow the heater to turn on until the water temperature reaches
20°F below the set temperature; unless programmed otherwise.

A Away from home =

[0 standard-Beginner =

@ Energy saving

& Super energy

B Weekender

A. Programming the economy cycles for all modes

D Settings Water Care Settings Water Care : 8:01 am
%5 Away from home

Designer Series

Settings Settings Settings Water Care 8:01 am

6 Away from home /7

D om D = s

c

Away from home: In this economy mode, the heater will not turn on until the
water temperature reaches 20°F below the set temperature.

Standard-Beginner: In this standard mode, the heater will maintain the set
temperature.
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Energy saving: In this economy mode, during the peak hours from Monday
to Friday, the heater will not turn on until the water temperature reaches 20°F
(11°C) below the set temperature. On the weekend, the temperature will be
maintained as programmed.

Super energy: In this economy mode, every day during the peak hours, the
heater will not turn on until the water temperature reaches 20°F below the set
temperature.

Weekender: In this economy mode, from Monday to Friday, the heater will not turn
on until the water temperature reaches 20°F (11°C) below the set temperature. On
the weekend, the temperature will be maintained as programmed.

Water Care button: Multi-purpose button. It can be used to select an option, to
go back to the previous menu, and to exit and return to the settings menu.
Pencil Icon: This icon will appear next to the water care mode that has been
programmed. Tap to enter that mode to make changes.

Trash Can Icon: This icon will appear next to an economy or filter cycle that
has been programmed. Tap to delete that cycle.

(e

ery day 7:00am 8:00am
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1. Tap (EZLIEE) to program cycles.

2. Then tap the plus sign, =, to add a new cycle or tap the cycle to change,
Weekend  1:00am 3:00am ||f .

3. Slide each column (Day, Start or Stop) and select the day and time to program. When done,
tap to return to the previous screen. Tap again to return to the settings menu.

B. Programming the filter cycles for all modes

Settings Water Care 8:01 am
?6 Away from home

Settings Water Care :

(Gold, Diamond & Diamond Wave Models)

1. Tap to program cycles.
2. Then tap the plus sign, =, to add a new cycle or tap the cycle to change,
Weekend 1:00am 1h30 .
3. Slide each column (Day, Start or Duration) and select the day and duration to program.

When done, tap @ to return to the previous screen. Tap again to return to the settings
menu.
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12.2 Maintenance Menu
Scheduled maintenance will keep your hot tub working at an optimal level. To help you accom-
plish this, reminders can be set to stay on track.

Settings Settings 8:01 am Settings Maintenance

H

é"

B Reminders > Reminders: Allows you to set a timer, for a preprogrammed amount of time,

that will countdown to remind you to either clean or replace certain components.

Osandby > =  Standby: A setting that will turn off all pumps for service. To return to normal
operation, just cancel the function. This setting will time out in 30 minutes.
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@ = Maintenance button: Multi-purpose button. It can be used to select an option,
to go back to the previous menu, and to exit and return to the settings menu.

A. Reminders

To enter one of the maintenance menus, tap the tab. To reset the timer, tap the tab to enter the
reset menu and tap the confirm tab. To reset tap EZIIER; to cancel tap to return to the
reminders menu. When a time allotted expires, a message will appear on the Home menu.

=
]

Rinse filter: A 30-day reminder to rinse the TGS lenance
filters.

ﬂ]ﬂ@ = Clean filter: A 60-day reminder to soak the C
filters in a cleaning solution.

Change water: A 120-day reminder to change
out the hot tub water.

Settings Reminders 8:01 am

Spa check: A 730-day reminder to have a
general check up performed. e

o~

©C [ e

= Change ozonator: A 540-day reminder to
change out the ozonator with a new unit.

Reset all reminders: Will reset all the
reminders, at the same time, to the maximum
setting.

O

Settings Reminders

Press Confirm once the
maintenance is performed

#ﬁ or Cancel to return to the @

previous menu

Confirm
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B. Standby 8:01 am
When you tap the “Standby” tab, this will turn the pumps OFF

to perform routine maintenance such as cleaning the filters. To return
to normal operations, press (T . This feature will timeout in 30
minutes. During the 30 minutes the display will remain in the Stand-
by menu.

12.3 Date & Time Menu

Programming the date and time is a simple and fast process. From the settings menu press the
“‘Date & Time” tab.

Settings Settings

9 Settings Date & Time

# il

Date & Time

Tap either the “Set Date” or “Set Time” tab. Once the tab is press,
the display will change and self-adjust to the current date or time. You
can also scroll the columns if you would like to make changes.

12.4 Keypad Menu

From the keypad menu, you can program features that the control panel
will display. Tap the “Keypad” tab to enter the programming features.

Settings Settings D Settings Keypad 8:01 am

o~

D Settings Temperature Units

A. Temperature Units

When you tap the “Temperature Units” tab, you program the units of
temperature to display. Tap either the Celsius or Fahrenheit tab to se-
lect the units to display.

&

B. Display ) By
When you tap the “Display” tab, you can select a viewing orientations Normal
for the control panel. Tap either Normal or Inverted to invert the display. = ¢~

This feature can also be accessed by tapping the & button from the
Home menu.

C. Contrast o Convs
When you tap the “Contrast” tab, you can change the contrast for the
control panel. Tap either Day or Night contrast to determine the best Cul
viewing option for the control panel. This feature can also be
accessed by tapping the @ button from the Home menu.

(, Night contrast
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D. Language

When you tap the “Language” tab, you select the display language for
the control panel. Tap the language you want to display on the control
panel. Scroll the language list to view all the available languages.

D Settings Language

12.5 Electrical Configuration Menu

The electric configuration menu is a feature that should only be access by a qualified technician.
Note: DO NOT make any changes to the configuration once the hot tub has been installed and

running. Contact ThermoSpas® if you have any questions.

Settings Settings Settings Electrical Config. 8:01 am

&

s
S

12.6 SmartTub® System (If Equipped)

IMPORTANT: The spa must have the optional SmartTub® system installed.

Advances in technology have allowed us to create a better and smarter hot tub. Our SmartTub®
system operates on a cellular network®. The advantages of this system are:
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« A more stable connection to Internet for outdoor environment. The SmartTub® device uses
much less data than a typical voice connection via cellular networks. We contract through the
largest wireless carriers to ensure maximum uptime. The system enables firmware updates
via the cell connection so your system’s performance will continuously be optimized remotely.

+ Maintenance is made easy by alerts sent to your phone.

+ Diagnostic alerts are sent to you and ThermoSpas® when attention is required.

* Visit https://smarttub.io/terms-of-service-html for more information.

Tap the “Wi-Fi” tab to load the available networks. Make sure that you have the SmartTub® app
installed on your device.

Settings Settings 8:01 am Settings Wi-Fi
Looking for networks

Cl Cal '

=

//I

Settings Settings Settings 8:01 am

# #

*Please note that if cellular service in your area is poor, SmartTub® may not function correctly.
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A. Pairing process

1. Download the SmartTub® app from the Google Play store or Apple App store.

2. Open the app and create an account.

3. Locate the SmartTub® sticker next the control panel of the hot tub. You can either scan the
QR code with the SmartTub® app or manually input the serial number located below the QR
code on the sticker.

4. After you pair the hot tub’s serial number to the SmartTub® app, the app will load and
connect the hot tub to the Internet.

5. Follow the instructions on the app to begin enjoying the benefits of your Internet connected
hot tub.

Note: The first year of data service is included. You will need to renew the subscription after the

first year. Please refer to the terms of service and privacy policy links in the SmartTub® app for

additional information.

B. Indicator Lights

Diamond & Diamond Wave Models)

There are indicator lights on the SmartTub® controller that relay the sta- m
B tus of the system. Below are meanings of the lights. SRR
) El
Y 1. Cloud:
* Blue light on - connected to cloud.
» Blue light off - not connected to cloud. :@ i
2. Spa: oo

-
* Blue light on - connected to spa controller \ /

* Blue light off - not connected to spa controller

3. Status:
* Cyan light - breathing (slow pulsing) indicates the status is good.
+ Cyan light - flashing indicates that the system is completing a connection to the cloud.
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* Green light - flashing indicates waiting for a connection to the cellular tower.
» Dark blue light - flashing indicates a SIM error.

4. Cell signal strength:
+ 3 blue LED lights indicates cell signal strength.

C. Resetting the SmartTub® controller
Should the SmartTub® controller need to be reset, hold a magnet to the reset label on the side of
the SmartTub® device.
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12.7 Miscellaneous Menu
This menu offers two features.

A. Warm weather
When the pumps run, they generate heat that is transferred to the water creating an overheat
situation. This setting will allow filtering although the temperature is high.

Settings Miscellaneous 8:01 am ERlings Warm weather Eoliam

S
®

12.8 About Menu Settings About 8:01 am ‘
This menu provides the software and electrical in.k1000 48 v19.06_07
information about the hot tub. in.yt 501 v8.01

v-level Config. 1
32 v2.00

12.9 Wave Lounge Control (Diamond Wave Models Only)
All Diamond Wave models are equipped with an auxiliary wave lounge
control. Use this to control the wave action massage that continuously
flows down the lounge jets. The wave function will automatically shut off
after 20 minutes of operation.

@ = Wave Button: Press to turn the wave action massage ON and OFF. You can
stop the wave lounge at any desired location.

12.10 Auxiliary Control (Gold and Concord II™ Diamond Models)
All Gold models and the Concord II™ Diamond model are equipped
with a single button auxiliary control panel that can be used to operate
the pump that provides water flow to the lounge jets. This control panel
provides on/off functionality for all jets in this seat at the same time. =

Pump Button: Press to turn jets I[gump 2o0r3
(depending on model) ON and OFF.

Light Button: Press to activate the lights.
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13.0 Topside Control Panel (Silver and Bronze Models)
13.1 Start-up Sequence

During the start-up sequence, the initializing screen will —
appear showing the software information and then display @ . @ e O \12'5]/ )
the Home menu. ) —

@ uGHT 82°F @ @
13.2 Color Control Panel Therranspas

Your ThermoSpas® hot tub is equipped with a state-of-the-
art control panel. You will be able to access sets of multi-level menus. Familiarize yourself with
the following information, so you can gain the full benefits
of your spa. By learning the key features of the control s

panel, you will navigate through the menus and program- &) -~ @ @ @/ &
ming with ease._PIease pay close attentionlto the ker ©) U 82°F 3\
points below. With the ease of use, there will more time to —— o

enjoy the benefits of your hot tub.

Note: Although the graphics on the LCD display are vivid
and colorful, the screen is not a touch-screen. These menus are activated by the buttons, such
as the Light button, Jets Pump 1, Jets Pump 2, and the Up and Down buttons.

= Settings Button: Press to enter the programming menus.

= Mode Button: Continuously tap to scroll and select modes - Spa, Light mode.

) = Light Button: Press to activate the lights. Will default to last color used. Also
used to make selections when navigating through the menus, page 35.

@
@ = Jets 1 Button:

Silver Models: Press to turn ON and OFF jets pump 1*. Also used to make
selections when navigating through the menus.

Bronze Models: Press to toggle between jets pump 1 LOW SPEED, jets pump
1 HIGH SPEED, and OFF*. If jets pump 1 is running in low speed mode due to
a heat call or filtration event, press to turn jets pump 1 HIGH SPEED ON and
OFF. Also used to make selections when navigating through the menus.

@,
@ = Jets 2 Button: Press to turn ON and OFF jets pump 2* (if equipped). Also used
to make selections when navigating through the menus. Replaced by Light
Color button on models with 1 jet pump.

_\"_ = Light Color Button: Replaces the pump 2 button on models with 1 jet pump.
w Used to change the color of the interior lighting without accessing menus.
/D = Temperature Control: Allows you to adjust the set temperature of the hot tub:
@ * Increase the temperature by tapping @ in 1° increments. Also used to make

selections when navigating through the menus.
 Decrease the temperature by tapping (¢) in 1° increments. Also used to
make selections when navigating through the menus.
Note: The temperature range for the hot tub is 59 to 104°F (15 to 40°C). When the hot tub is
heating or cooling a message will appear on the Home Menu.

*Anytime a pump has been manually turned on, it will automatically turn off after 20 min-
utes. If at you desire more jet operation you may simply turn the pump(s) back on.
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14.0 Operating and Programming Instructions (Silver

and Bronze Models)

14.1 Home and Jets Menu

The Home Menu is the menu displayed at all times. If there is no
activity for 20 minutes, the display will time-out into a sleep mode. To o
reactivate the display, press any button on the control panel. @ @ @
NOTE: When a feature is on, the icon will be animated.

12:15pm 82°F

2 Jet Pump Modelgzdlgl Panel

[ ]
@ = Jet 1 Button: Silver models: Press the Jets Pump

S 1 button to turn the pump #1 on and off. Will be
animated when the pump is ON.
Bronze Models: Press to cycle between pump #1 low speed, high speed and
off. If pump #1 is already on in low speed mode due to a heat call or filtration
event, cycle between high and low speed. Animated when pump is ON.
Animation speed increases when in high speed.

® 1 Jet Pump Model trolg ?\Wel
@ = Jet 2 Button: Press the Jets Pump 2 = N Y/

button to turn the pump #2 on and off. Will be animated if the
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JETSICON  JETS ICON

pump is ON.
WHEN OFF  \WHEN ON
@ = Light Icon: Press to turn the lights ON. Will illuminate when the lights are ON.
12:15pm = Time Icon: Displays the current time, page 39.
82°F = Current Temperature Icon: Displays the current water temperature.
82°F = set Temperature Icon: Displays the current set temperature and its status.

14.2 Lights Menu
There are many lighting options that help enhance your hot tub experience.
Note: The lights automatically turn off after 2 hours. They can be reactivated if needed.

SETTINGS In Mlx Q

&)
@ LIGHT
MODE D
m 3

4
-

1?\

@@ 6

Light Button: Press to turn ON the lights. The main, indicator, exterior (if
equipped) and step lights (Silver models only) will activate.

= Mode Button: Press to enter the lighting options menu.

Jets Pump 1 Button: Press to turn ON zone 1 lights. This will activate the
main spa light and bullet lights. When feature is ON the zone 1 icon will be
illuminated.
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= Jets Pump 2 Button: Press to turn ON zone 2 exterior lights. The only light
color option is white. Feature only available on certain models. When feature is
ON the zone 2 icon will be illuminated.

Up or Down Button: Use to scroll through all the lighting options from a solid

[ ]
&
N
@ color to a blending of all colors.

Zone 1 Icon: When feature is ON the icon will be illuminated.

Zone 2 Icon: When feature is ON the icon will be illuminated.

(Silver & Bronze Models)

14.3 Water Care

Your hot tub is equipped with 5 programmable water care modes. Each of the modes are
described below.

. Water Care
e Water Care 9,
& &\
A o B
LIGHT <
&) — S @) .4 ;J Beginner
MODE o

o Fnarmuv Qavinae

Note: Economy mode will not allow the heater to turn on until the water temperature reaches
20°F below the set temperature; unless programmed otherwise.

25 Away = Away from home: In this economy mode, the heater will not turn on until the
water temperature reaches 20°F below the set temperature, unless programmed
otherwise. You can program one economy cycle and one filtration cycle.
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= Standard: In this standard mode, the heater will maintain the set temperature.
You can program two filtration cycles.

& Energy = Energy saving: In this economy mode, during the peak hours from Monday
to Friday, the heater will not turn on until the water temperature reaches 20°F
(11°C) below the set temperature, unless programmed otherwise. You can
program one economy cycle and one filtration cycle. On the weekend, the
temperature will be maintained as programmed.

&= swerkrersy. . = Super energy: In this economy mode, every day during the peak hours, the
heater will not turn on until the water temperature reaches 20°F below the set
temperature, unless programmed otherwise. You can program one economy
cycle and one filtration cycle.

| Weekender = Weekender: In this economy mode, from Monday to Friday, the heater will
not turn on until the water temperature reaches 20°F (11°C) below the set
temperature, unless programmed otherwise. You can program one economy
cycle and one filtration cycle. On the weekend, the temperature will be
maintained as programmed.
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Note: All economy modes have the option to program one economy cycle

Designer Series

Programming the economy and filtration cycles for Away, Energy, Super Energy, and
Weekender modes

Water Care

and one filtration cycle. Pressing ( (& ) will exit the menu and return to
the Water Care Menu at any time.

1.
2.

3.
4.
5

1.

12.

13.

B.

Press ( (A ) or ( (¥ ) to scroll through the water care options.

I(Ds the light l))utton (@ ) to select one of the water care modes, ; Standard
:

Press (&3 ) to enter the programming for that cycle. SRR
Press the light button ( #) ) to select the day option, pav  [EEIEE].

Press ( (A ) or ((®) ) to scroll through - Every Day, Sun, Mon, Tue, @ Econ. #1
Wed, Thu, Fri, Sat, Mon-Fri, or Weekend. Once a selection is made,

press the light button ( () ) to save and move down to program the

start time, st IR Day Every day
Press ( N ) or ( () ) to scroll through the time, in increments of 30 Start 12:00am
minutes. Once a selection is made, press the light button ( e ) to Stop 12:00am
save and move down to program the stop time, ‘st @j

Press (@) ) or ( (») ) to scroll through the time, in increments of 30 @ Filt. #1 <
minutes. Once a selectlon is made, press the light button ( ¥ ) to

save.
Press ( () ) to move down to the Filtration menu and program the Day Every day
settings. Start 12:00am

Press the light button ( #) ) to select the day option, pav B Duration  2.0h

. Press ( (A ) or ( (¥ ) to scroll through - Every Day, Sun, Mon, Tue,

Wed, Thu, Fri, Sat, Mon-Fri, or Weekend. Once a selection is made, press the light button (
(@) ) to save and move down to program the start time, ‘St | 12:00am |

Press ( (A (A ) or ((®) ) to scroll through the time, in increments of 30 minutes. Once a
selection is made, press the light button ( () ) to save and move down to program the
duration time, Puration )

Press ( (& ) or ( (¥) ) to scroll through the time, in increments of 30 minutes for a time period
between 0.5h to 24h. Once a selection is made, press the light button ( %) ) to save.

Press ( (&® ) to exit and return to the water care menu. Press ( &) ) return to the main menu.

Programming the filter cycles for all modes Water Care

Note: Standard mode is the only option that has two filtration programs.
Pressing ((&® ) will exit the menu and return to the Water Care Menu at

any time. @

1.

2.
3.
4

Press the light button ( ) ) to select the standard water care mode,

( )- 0 Enarow Qauinne
Press (&3 ) to enter the programming for that cycle.
Press the Ilght button ( @) ) to select the day option, vy [EEE. o Fit# g

Press ( (A ) or ( (¥ ) to scroll through - Every Day, Sun, Mon, Tue,

Wed, Thu, Fri, Sat, Mon-Fri, or Weekend. Once a selection is made,

press the light button ( (#) ) to save and move down to program the Day Every day
start time, sert [EEXIEN. Start 12:00am
Press ( N ) or ( () ) to scroll through the time, in increments of 30 Duration 2.0h
minutes. Once a selection is made, press the light button ( @ ) to

save and move down to program the duration time, Duratien
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(Silver & Bronze Models)
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6. Press( (A ) or ( (¥ ) to scroll through the time, In increments of ® Filt. #2 o
30 minutes for a time period between 0.5h to 24h. Once a selection
is made, press the light button ( ) ) to save.

7. Press ((¥))to move down and program the second filtration cycle. | pay Every day
Follow the steps above to program. Start 12:00am

8. Press (&) ) to exit and return to the water care menu. Press ( () ) | Duration  2.0h
return to the main menu.

14.4 Maintenance Menu

Scheduled maintenance will keep your hot tub working at an optimal level. To help you accom-
plish this, reminders can be set to stay on track. From the Settings menu, use the up/down but-
tons to select the “Maintenance” tab press ( (@# ) to enter the submenu. To make
changes, press ( () ) again to enter the reminders or standby options.

Maintenance

SETTINGS

@ Maintenance <= @ @
8 LIGHT @ standby v
%&5{ “ " @2) N\ @ Standby
Bremnders > = Reminders: Maintenance reminders that will countdown to remind you to either
clean or replace certain components.
Osandby > =  Standby: A setting that will turn off all pumps for service. To return to normal
operation, just cancel the function. This setting will time out in 30 minutes.
Reminders
Reminders
% = Rinse filter: A 30-day reminder to rinse the filters. : <+

Clean filter: A 60-day reminder to soak the filters in a _

cleaning solution.

[

I Clean Filters
...“Iu v Required in 45 days

Change water: A 120-day reminder to change out the
hot tub water.

i

Resetting the timer for the reminders

Spa check up: A 730-day reminder to have a general check up performed.

Once a timer has expired, a message will appear on the main menu. sl e ‘
Make sure to preform the action required to maintain your hot tub at an Press done if the
optimum level. To reset the timer follow the steps below. maintenance is

Note: Pressing ( (&3 ) will exit the menu and return to the Water Care performed

Menu at any time.

1. While in the reminder options, select the tab that needs to be reset Done

(& moerrsays ). Use the up/down buttons to navigate through the
options. Press ( ) ) to enter the reset option for that tab.

2. The menu will change to a warning message. If the task has been performed, press ( @ ) to

select done and reset the timer. If not, press ( &# ) to exit the menu and return to the reminders
menu.
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Standby Standby <+
This feature turns the pumps OFF to perform routine maintenance such as
cleaning the filters. This feature will timeout in 30 minutes. During the 30 All pumps off!

minutes the display will remain in the Standby option.
Note: Do not exit this menu, doing so will cancel the Standby mode and
allow the pumps to be activated.
1. From the maintenance menu, press ( (¥) ) to navigate to the

“Standby” tab, [TIEEIC .
2. Press (@) ) to enter the submenu. A screen will display “All pumps off!”.
3. Press( @ ) to exit the menu and return to the Maintenance Menu.

14.5 Date and Time Menu

Programming the date and time is a simple and fast process. From the settings menu, use the up/
down buttons to select the “Date & Time” tab [ LESCMEIN. Press ( (@) ) to enter the submenu.

Date & Time <

Ge

be:
- et Format: AM/PM
Q) Year: 2019
o Nata- 1lan N2

A. Selecting the time format

1. While in the Date & Time options, use the up/down buttons to navigate through the options
and select the “Format” tab, [l LG,

2. Press (@) ) to enter the format option, Format: AP |

3. Use the up/down buttons to navigate through the options, Format: EEZM or Format:  EZIN.

4. Press (3 ) to save your selection.

5. Press ( ) ) to exit the menu and return to the Date & Time Menu.

B. Selecting the year

1. While in the Date & Time options, press ( (¥) ) to navigate to the year tab, [N,

2. Press (@) ) to enter the year option, Year: .

3. Use the up/down buttons to navigate through the years.

4. Press (@ ) to save your selection.

5. Press ( &) ) to exit the menu and return to the Date & Time Menu.

C. Selecting the date

1. While in the Date & Time options, press ( (X)) to navigate to the date tab, [l .

2. Press (@) ) to enter the month option, pate:  [EJ 02 . Use the up/down buttons to navigate
through the months.

3. Press (@) ) to enter the day option, pat:  Jan [7l. Use the up/down buttons to navigate
through the days.

4. Press (@ ) to save your selection.

5. Press ((&¥ ) to exit the menu and return to the Date & Time Menu.
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D. Selecting the time

1. While in the Date & Time options, press ( (X)) to navigate to the time tab, L] |

2. Press (@ ) to enter the hour option, Time: [Elissam . Use the up/down buttons to navigate
through the hours.

3. Press (@) ) to enter the minutes option, Tme:  10fHam . Use the up/down buttons to navigate
through the minutes.

4. Press (@ ) to enter the AM/PM option, Time:  1035[1] . Use the up/down buttons to switch

between AM or PM.

Press () ) to save your selection.

Press ( ) ) twice to exit the menu and return to the Settings Menu.

o O

14.6 Keypad Menu

From the settings menu, use the up/down buttons to select the “Keypad” tab JERETERN.
Press (@) ) to enter the submenu.

Note: The lock feature is not available.

Keypad <

SETTINGS

&

e}
[}
-

T A
w Keypad

@ LIGHT #* Config. English

I ®

NArmal

Selecting the temperature display

When you enter the submenu, the temperature display tab is selected, FEE.
Press (@) ) to enter and change the option, & F |

Use the up/down buttons to switch between °C or °F.

Press () ) to save your selection.

Press ( & ) to exit the menu and return to the Keypad Menu.

aOrON~D>

Selecting the language

While in the Keypad options, press ( () ) to navigate to the language tab, K=Y
Press () ) to enter and change the option, @ English |8

Use the up/down buttons to scroll through all the language.

Press ( @ ) to save your selection.

Press ( (&% ) to exit the menu and return to the Keypad Menu.

oo~ m

Selecting the orientation of the display

While in the Keypad options, press ( (¥) ) to navigate to the normal tab, [EITEEEN.
Press (@) ) to enter and change the option, e = .

Use the up/down buttons to switch between a normal or inverted screen display.
Press ( @ ) to save your selection.

Press ( (&) ) to exit the menu and return to the Keypad Menu.

o= O

14.7 Electrical Configuration Menu
The configuration menu is a feature that should only be accessed by a qualified technician.

Note: Do not make any changes to the configuration once the hot tub has been installed and is
running. Contact ThermoSpas® if you have any questions.
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15.0 Basic Spa Maintenance

Keeping your spa operating for maximum enjoyment requires a simple maintenance routine.
Following the procedures below at the recommended intervals will insure that your spa provides
years of service. If you have any questions concerning the maintenance of your spa please con-
tact ThermoSpas® Customer Care department at support@thermospas.com.

Cleaning and chemical products for your spa can be purchase at ThermoSpas® online store at
online.ThermoSpas.com.

ltem Frequency
Water level and Condition Of Spa Daily

Cover Daily

Spa Temperature Daily

Foreign Objects or Debris in Spa Daily

Clean Shell Above Water Line Weekly

Clean Filter(s) 3 weeks Max. and at each drain & refill
Drain and Refill Spa 4 months Max.
Flush and Clean Lines Each Drain & Reéfill
Clean the Spa Cover Monthly

Clean and Protect Cabinet As recommended

1. Daily Maintenance

+  Check for leaks by walking around the spa and looking at the base of the cabinet for signs of
water.

* Be sure the spa cover is in place and tied down to the spa.

*  Check spa temperature.

* Look for any signs of external damage to the spa and spa cover.

*  Remove any foreign objects or debris that may have fallen into the spa.
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2. Check Sanitizer Level
*  Check sanitizer level and adjust as necessary, two to three times a week.
3. Weekly Maintenance
* Add Stain and Scale.

Add Protection Plus or Natural and Clean.
Shock Spa.

4. Scheduled Maintenance

Clean the shell above the water line with ThermoSpas® All Purpose Cleaner once a week.
All Purpose Cleaner will not alter the water chemistry, or scratch the acrylic shell.
ThermoSpas® does not recommend the use of household cleaners on the spa shell. Most
will alter the water chemistry and some contain abrasives that scratch and dull the spa shell.
«  The Scum Mitt offered by ThermoSpas® is ideal for use with the All Purpose Cleaner.

P

B. Clean the spa filter(s) at least every 1-3 weeks depending upon usage.

*  Follow the cleaning process outlined in this manual.

+ If the spa is used heavily the filters should be cleaned at more frequent intervals.

* Having a second set of filters on hand is strongly recommended as they greatly reduce the
down time the spa requires for filter maintenance.

41


http://online.thermospas.com

O
@)
C
®
-
Q
et
L
©
>
®
Q
)
S
N
®
M

Designer Series

C. Drain and refill the spa every 3 to 4 months

*  Follow the drain and refill procedures in this manual.

» Each time the spa is drained and refilled the lines should be flushed and cleaned. Follow the
procedure outlined in this manual.

* Itis recommended the entire shell surface be cleaned and protected each time the spa is
drained and refilled. Use ThermoSpas® All Purpose Cleaner and ThermoGloss as outlined in
the procedure in this manual.

*  Thefilter(s) should be cleaned with each drain and refill.

+  Spas that are used heavily will require more frequent drain and refill cycles.

+  Conditioning the Cover Monthly.

«  The cover should be thoroughly cleaned and conditioned once a month using ThermoSpas®
Cover Conditioner.

«  Cleaning and Protecting the Cabinet.

+  Cabinets constructed of ThermoBoard require hosing and wiping down once or twice a year.

Cleaning and chemical products for your spa can be purchase at ThermoSpas® online store at
online.ThermoSpas.com.

16.0 Changing/Cleaning Filters

We strongly recommend that you clean the filter every one to three weeks depending on how
often your spa is used. Just because a filter is dirty does not mean it needs to be replaced. Fil-
ters that are cleaned regularly can last up to 12 months. To determine whether your filter needs
replacing look within the pleats of the filter inspecting for any build up of grime and dirt particles
after cleaning. If dirt particles remain the filter should be replaced. Filters are not designed to last
more than 12 months. We recommend using ThermoSpas® Filter Clean to clean the filter(s) in
your spa.

Note: Some ThermoSpas® spas use two or more filters.

A DANGER: RISK OF SEVERE INJURY OR DROWNING BY ENTRAPMENT!
+ Keep hair, loose articles of clothing or hanging jewelry away from suction fittings, rotating jets
or other moving components to avoid entrapment that could lead to drowning or severe injury.

* Never use the spa unless all suction guards, filter, filter lid, or skimmer assembly are installed
to prevent body and/or hair entrapment.

* Never operate or use the spa if the filter, filter lid, or skimmer assembly are broken or any part
of the skimmer assembly is missing. Please contact your dealer or nearest service center for
service.

» The suction fittings and suction covers in this spa are sized to match the specific water flow
created by the pump(s). If it is necessary to replace the suction fittings, suction covers or
pump(s), be sure that the flow rates are compatible and are in compliance with the VGB
Safety Act.

* Never replace a suction fitting or suction cover with one rated less than the flow rate marked
on the original suction fitting. Using improper suction fittings or suction covers can create a
body or hair suction entrapment hazard that may lead to drowning or severe injury.

« Owners must alert all spa users to the potential risk of Hair, Limb, Body, Evisceration
(disembowelment) and Mechanical Entrapment.
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Cleaning The Filter

DANGER: TURN POWER TO SPA OFF! TO DECREASE RISK OF DEATH, DROWNING, OR EN-
TRAPMENT, NEVER OPERATE SPA WHEN FILTER IS NOT PROPERLY INSTALLED OR IF SKIM-
MER ASSEMBLY IS DAMAGED OR ALTERED!

During filtration and automatic cycles, water flows through the spa skimmer and into the filter
cartridge(s) to trap suspended particles and oils on their surface pleats. To ensure optimum
performance, it is necessary to remove and clean the filter cartridge(s) once a month or sooner
depending on spa use and water quality.

Cleaning products for your spa can be purchase at ThermoSpas® online store at
online.ThermoSpas.com.

Easy Top-Access Filter Cleaning Procedure (Do not use a pressure washer):
1. TURN POWER TO SPA OFF!

2. Remove filter lid by pulling it upward.

3. Remove filter cartridges by grasping top filter
handle and unscrewing it from the fitting.

4. Clean filter cartridges by first filling the bucket with
water, adding 8 oz. of ThermoSpas® Filter Clean.
Mix solution by moving filter cartridges up and
down several times. For best results, allow filters to

Skimmer
Assembly

=

soak for 12 to 24 hours (never less than 3). Top View of Skimmer
5. After soaking, remove filter and rinse out any Skimmer 5, Lid
. . . . Assembly
remaining debris. You can do this using a garden
hose with high-pressure nozzle. After rinsing, allow Sk Lig / o
filters to air dry. e
Note: If you are experiencing calcium deposits on your  exposing Z

filter, (a white, chalk-like substance), you may need to

filters =~

soak your cartridge in “Filter Clean” for an extended pe-
riod of time. Calcium deposits are an indication of very hard water. For instructions on what to do
if your water is unusually hard, please refer to the Chemical Care Guide that comes with your hot
tub. If you are still experiencing problems, contact the ThermoSpas® Customer Care Department
at 800.876.0158.

6. To install cartridges, grasp top filter handle and screw the filter back onto fittings.
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17.0 Spas with ThermOzone™

Components

) 0zone Generator : Using Corona discharge
technology, the Ozone generator delivers Ozone to the
Mixing Vessel.

@ Mixing Vessel : Using Venturi action, the Mixing Vessel
pulls ozone from the Generator and mixes it with Spa
water fed from the circulation pump. An overflow tube
feeds unused ozone to the carbon filter, but an internal
valve keeps water from entering the carbon filter. Treated water is sent back to the spa via
the ozone jet.
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Q Carbon Filter : Any excess ozone is passed through the Carbon Filter and is neutralized of
its oxidation effectiveness, releasing harmless oxygen underneath your cabinet.

Q Ozone Jet : A special laser jet provides a return back to the spa for the treated water,
reference page 16 for location.

Operation
In spas equipped with a circulation pump, the ThermOzone™ system is active any time the circu-
lation pump is running.

Chemical Usage

1. Spas that have ThermOzone™ installed should maintain a 1.0-3.0 ppm Chlorine level or a
1.0-3.0 ppm Bromine Level.

2. Depending on your usage, and if your water is clear, you can continue to reduce the amount
of chemicals you are using by trying to add sanitizer on a once weekly schedule, and
performing the rest of your weekly maintenance (Stain and Scale, Natural and Clear etc...)
on a bi-weekly basis.

Note: Chemicals must be maintained at a proper level. Take into consideration how often the
hot tub is used and the number users.

3. For ThermOzone™ to work more efficiently, please remember to clean your filters weekly.
Make sure you go no longer than one month between filter cleanings.

Note: If water becomes cloudy, please resume all chemical maintenance on a regular weekly
basis. If your usage increases, you may have to add an additional sanitizer treatment in the mid-
dle of the week.
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18.0 Drain and Refill

Drain and refill the spa at least every 4 months. It is recommended that the plumbing lines be
flushed and cleaned each time the spa is drained, page 46.
Note: This is also an excellent time to change and clean the spa’s filter(s).

1. Turn the spa circuit breaker off.

2. Grab one of the corner panels, from the bottom, where it touches the bottom pan. Then
gently pull the panel forward to unsnap it from the holding clip then pull down to remove.
Place the panel in a safe location to prevent from damaging it.

3. Pull back the ThermoFoil to expose the foam inserts.

4. Gently pull out the foam inserts to expose the equipment bay.

5. Locate the drain valve. Normally the drain valve will be attached to a 2 x 6 wood slat with tie
wraps. Cut the wraps and gently pull the drain valve from the equipment bay.

6. Hold the drain hose above the water line, then unthread the drain cap from the hose. Place

the drain and hose on the ground to direct the water away from the spa.

7. Use a foam sponge, mop, or wet/dry vacuum to remove any remaining water left in the
bottom of the spa footwell or in seating areas.

Note: You can use a submersible pump.

8. Completely dry the shell surface with a soft, clean cloth.

9. Clean the shell surface of any debris or mildew using ThermoGloss and ThermoSpas® All
Purpose Cleaner.

10. Once you have completed all tasks above, reinstall the drain cap. Place the drain hose back
in the equipment bay. Reinstall the foam inserts, ThermoFoil, skirt panel and trim.

11. You are now ready to refill the spa.

12. Periodic visual inspection must be made to detect any leaks within the cabinet.
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Cabinet Drain
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000
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Unclip left corner panel

i EN I

Left corner panel removed Note: If you do not wish to use the built-in
Drain Valve, you can drain the spa using
either a submersible pump or a siphon.
While this may eliminate the requirement
to remove the cabinet, the power to the

™ Foil folded back - spa circuit breaker must still be turned
ermoroll folded bac off, and the shell should still be dried and

cleaned as described above.

to reveal foam inserts

DRAIN
VALVE

Foam inserts removed
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19.0 Cleaning the Cover

While your vinyl cover is made to withstand the elements, it is important to care for it by keeping it
clean at all times. Many contaminates may stain the vinyl if left on over a period of time. Remove

stains immediately! Note: It is highly recommended that you DO NOT put the seam over the con-
trol panel. This will cause premature failure of the control system.

Conditioning the Cover

Conditioning the spa cover monthly will prolong its life. We recommend using ThermoSpas®
Cover Conditioner. It helps keep vinyl from hardening and cracking, and is especially effective for
covers exposed to harsh outdoor elements like the sun’s ultra-violet rays, snow, and sleet. Cover
Conditioner should only be used on the topside of the cover. To clean the underside of the cover
simply use a garden hose and a 2:1 mix of water and vinegar. You can use bleach, simply spray
and clean the underside and rinse thoroughly. Allow cover to dry.

Note: Do not use petroleum-based vinyl cleaning products because they may be harmful to the
cover and will void its warranty.

1. Apply ThermoSpas® Cover Conditioner full strength with a damp sponge or soft brush, make
sure to use gloves.

2. Leave the conditioner on the cover for three minutes. Areas with excessive dirt or residue
build-up may need extra scrubbing.

3. Wipe the cover clean with a damp sponge or cloth.

4. Rinse the cover with water.

Cleaning products for your spa can be purchase at ThermoSpas® online store at
online.ThermoSpas.com.

20.0 Flushing Lines

There are many plumbing lines in a spa. No matter how clean you keep the water, chemicals
clean only the water, not the plumbing lines. Bacteria and mildew-attracting scum can accumulate
in the vast number of spa plumbing lines and fittings. You need to flush and clean them to prolong
the life of your spa and keep it running smoothly.

Flushing and cleaning needs to be done every 6 months to one year, or if you notice a film devel-
oping around the spa fittings. You should perform this procedure just before you drain your spa.
We recommend using ThermoSpas® Jet Line Cleaner to dissolve the build up of body oils, dirt,
hair, soap, scum, rust and mineral deposits which are the perfect breeding ground for bacteria
and mold.

Note: Some residual foaming may occur, if so, use ThermoSpas® Foam Away to suppress foam.

1. Remove filter(s) and clean.

2. Before spa is drained, empty contents (16 fl. 0z.) of ThermoSpas® Jet Line Cleaner in to
warm spa water.

Turn pump(s) “on” and run jets for 15 minutes. (Ensure filter is not in spa and cover is
closed.)

Turn pump(s) and jets “off” and let sit for 1 hour.

Turn pump(s) “on” and run jets and blower for 15 minutes.

Drain the spa, hosing off the inside walls while draining.

Proceed to clean the spa shell as instructed in the “Drain and Refill” section, page 45.

w

NOo O

Cleaning products for your spa can be purchase at ThermoSpas® online store at
online.ThermoSpas.com.
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21.0 Shell Surface Cleaning

Cleaning Above the Water Line

The perfect product for cleaning the shell surface above the water line (when the spa is filled) is
ThermoSpas® All Purpose Cleaner. This helps to prevent a scum line from forming. Because it is
a natural enzyme, it will not affect the water’s chemistry, it's safe to use, it won’t scratch the acryl-
ic, and it helps to eliminate mold or mildew odors without bleaching the surface.

Note: Beware of using products such as Windex, as they will alter the water’s chemistry; or other
abrasive cleansers that can scratch the acrylic surface.

1. Spray the exposed surface area of the shell above the waterline with All Purpose Cleaner.
This will not affect the water chemistry.

2.  Wait a few minutes and then simply wipe away the grime with a soft cloth or damp sponge.
For heavily soiled areas, spray generously, wait five minutes and scrub with a two-textured
sponge. ThermoSpas® offers an accessory called the Scum Mitt, which is perfect for this
use.

Deep Cleaning the Entire Shell Surface

Anytime the spa is drained and dry, we recommend two products when cleaning the entire shell
surface: ThermoGloss and All Purpose Cleaner. ThermoGloss helps create a hard, durable, pro-
tective coating on the shell that seals the surface and hides scratches in the acrylic. All Purpose
Cleaner is ideal for ridding the surface of any dry residue.

Note: Do not use car wax of any kind.

1. Remove any scum lines using All Purpose Cleaner.

2. Shake ThermoGloss well before using and apply only on the shell surface. The surface
should be completely dry upon application.

3. Spread evenly using an overlapping circular motion.

4. Allow the ThermoGloss to dry, spray All Purpose Cleaner on the dry residue left by the
ThermoGloss, and wipe the shell surface clean with a dry, soft cloth.

Cleaning products for your spa can be purchase at ThermoSpas® online store at
online.ThermoSpas.com.
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@) 22.0 Winterizing (Closing Your Spa)

If you do not plan to use your spa during freezing weather, you will have to winterize it. Failure
to winterize your spa will cause irreversible damage (in freezing temperatures) to the pump and
plumbing lines.

Winterization of your spa is easy. Follow the steps below each time you drain the water from your
spa in freezing temperatures to prevent serious damage from occurring to your spa:

Turn the spa circuit breaker off.
Open all therapy control valves and all jets, page 22.

Drain your spa, page 45. You can use a submersible pump.

Remove the cabinet panel(s) in front of the spa’s equipment compartment.

Open the drain valve to drain any remaining water and leave open afterwards.

Locate the heater and open the heater unions at both ends by turning counter-clockwise,

page 50.

Clear water from the water pump(s) suction and return lines using a canister-type wet

vacuum. You MUST use a canister type wet vacuum in order to ensure that the lines are

cleared of all remaining water.

8. Remove the drain plug(s) from all water pump(s), page 49.

9. Replace the drain plug(s) after all the water has drained.

10. Reconnect the heater unions on the heater at both ends by turning clockwise until they are
tight. Make sure o-ring gaskets are sealed properly so as not to pinch o-rings. Do not over-
tighten.

11. Put the cabinet panel in front of the equipment compartment back on.

12. Turn the spa circuit breaker on.

13. Briefly turn the blower, if equipped, ON to expel water from the plumbing and air channels.

14. Turn the spa circuit breaker off.

15. Use a wet vacuum at EACH fitting/jet/suctions to assist in removing any existing water in
fittings, water lines and spa shell.

16. Sponge out remaining water from spa shell.

17. Clean the shell and remove any debris.

18. Clean the filter. Store the filter basket and filter(s) element indoors.

19. Install the insulated spa cover and check to ensure that rain water and/or snow is not
entering the spa through the cover.

20. You must cover the spa with a tarp to keep water out while unit is down.

21. Remove snow load for longer cover life expectancy.

N

Customer Responsibilities

Any spa is subject to freezing in cold weather. You must follow these procedures during a power
failure or if the spa is not operating properly in order to prevent your spa from freezing. Freezing
is not covered under the warranty.

Note: To assist with water circulation you can use a submersible pump. Place the pump in the
footwell of the spa, facing upwards. (Do not attach water hose to the pump.) This creates a wa-
terfall and keeps the water moving. Leave the pump running until the spa is repaired. Keep the
spa covered and all panels on the unit. The submersible pump will also generate heat and protect
the spa for a period of time.

Preventative Maintenance

During the cold weather season, you should inspect your spa every day to ensure it is running
properly. If you detect a problem and the temperature is dropping, contact the service department
immediately during regular working hours. It is the customer’s responsibility to follow the proce-
dures listed above in order to prevent a freeze up.

Note: Spa should be covered with a tarp after closing process. Covering your spa with a tarp
might protect and keep the spa from getting water into it as it sits dormant.
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23.0 Components

TO WATER JETS T

Water Pump
“T” Valve

NOTE: On some water Valve Lock

pumps, pipes heading to water

jets may be located on the

top of the pump. However,

the configuration of the hose,

“T” valve, remains the same.

Pump configuration vary by

model. From Suction/

Self Priming Hose
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Water Pump
Volute
Open Valve  Closed Valve TO WATER JETS
Pump
. . . . Motor
Circulation/Filtration Pump
Diamond Wave, Diamond,
Gold and Silver trim level From
i . Suction
Designer Series Spas are _
equipped with a circulation
pump for filtration. Pump con-
figurations vary by model. T
Water
Pump
Volute

Air Pump (Blower)

/Motor

Designer Series Spas are
equipped with an air blower
for the Bubbling System (not
included with the Silver or
Bronze Models).

L TO AIR JETS
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Spa Pack and Heater
(Electronic Center of Spa)

The Spa pack is normally
behind the cabinet located
underneath the topside control
panel.

Heater

Heater Unions (hand tighten
only by turning clockwise)

Spa Light Assembly

The LED light is attached to the light lens by screwing on to it. The light housing is accessible
from underneath the skirt panel for ease of replacement.

Led Light
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Grommet

Lens
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24.0 Common Diagnostic Messages
24.1 Topside Control Panel Error Codes

Error Code Meaning Action
DO NOT ENTER THE WATER!
Overheat - The spa water tem- Remove the spa cover and allow
OH perature has reached 108°F water to cool. If spa does not reset, turn off
(42°C). the power to the spa and contact Thermo-
Spas Service Department 800.876.0158.
The temperature inside the spa . .
AOH cabinet is too high, and the control Shut down all .manuaIIy actlvatgd functlons,
. . Open spa cabinet to allow ventilation.
system is overheating.
Hr An internal system hardware error | Contact ThermoSpas Service Department,
has been detected. 800.876.0158.
A probl_e m with the circuit board Contact ThermoSpas Service Department,
Prr regulation probe has been
800.876.0158.
detected.
UPL No configuration is detected in the | Contact ThermoSpas Service Department,
system memory. 800.876.0158.
. o . If the problem persists, contact Thermo-
f) H
HL High Limit circuit has trippeds Spas Service Department 800.876.0158.
A potential freeze condition exists. | No Action required. The pumps and blower
ICE Activates when the temperature will automatically activate to circulate the
goes below 44°F (6.7°C) water regardless of spa status.
FLO FLO Condition - Flow restriction. Check filter, pump, blockage, air lock, and
water level

24.2 Exterior Status Light
Under normal operating conditions, the exterior status light will be solid blue to show that there is
power going to the spa.

If there is a FILTER or OZONE reminder message on the main control panel, the exterior status
light will blink blue.

If the spa has entered an error state, the exterior status light will turn solid red. In the event of
loss of communication with the spa, the light will blink red.

Condition Maintenance LED (BLUE) Error Status LED (RED)
No errors Solid Off

Filter or Ozone reminder* Blinking Off

Any error Off Solid

Communication lost Off Blinking

*If there is a maintenance reminder AND the spa is in an error condition, the error condition will
be prioritized over the maintenance reminder, and the status light will be red to indicate the error
condition. Once the error is resolved, the light will resume blinking blue to indicate the reminder.
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Designer Series

Problem

Possible Cause

25.0 Troubleshooting - Water Chemistry

Solution

Cloudy Water

+ Dirty Filter
* High TDS Levels
* High pH or alkalinity

» High calcium count
e Dissolved solids
e Dissolved solids

Clean filter with filter cleaner
Drain and refill with fresh
water

Check and adjust using pH/
Alkalinity Down

Drain halfway and refill

Add clarifier to your water
Shock with sanitizer you
currently use

Brown Water

* High mineral count
* Low alkalinity level
* Low sanitizer level

Add “Stain & Scale”
Test and add pH/Alkalinity Up
Test and add sanitizers

Green Water

. Alg_}ae g_;rowth

Shock with sanitizer

Yellow Water

 Low pH

Add pH Up

White Scale Deposits

* Low sanitizer level

Test and add sanitizer

Excessive Foaming

« Soft water
* High TDS level
* High contaminant level

Test and add “Liquid Calcium”
Drain and refill the hot tub
Add one capful of “Foam
Away”

Waterline Scum Ring

* Inadequate filtration
» High content of oils

Check and clean filter(s)
Add “Natural and Clear”

Pitting of Metal Fixtures

« Low alkalinity or pH

Check and add pH/Alkalinity
Up

Erratic pH Test Results
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* Low alkalinity
+ Sanitizer level too high

* Old pH indicator strip

Add pH/Alkalinity Up
Remove cover and turn on
bubbling system

Check expiration date and
replace

Musty Odor

» Bacteria/algae growth

Shock the water with
sanitizers

Eye Irritation

* Low pH level
* Low sanitizer level

Test and add pH/Alkalinity Up
Test and add sanitizer

Skin Irritation

* Low sanitizer level
e Sanitizer irritation

« Water temperature too high
* Soaking too long

Test and add sanitizer

After adding sanitizer always
wait 20 minutes before
entering hot tub

Reduce water temperature
Soak for shorter intervals
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26.0 Troubleshooting - Mechanical Systems

Solution

Problem

Possible Cause

Pump(s) will not start

“T” valve(s) not open

Pump(s) not primed

Frozen pump impeller

Check both “T” valves on all
pumps. Be sure valve is open by
pulling up on handle until detent
click is felt. Detent prevents valve
from vibrating shut.

Open suction side pump union
until water begins to trickle.

Use hairdryer to warm pump
volute in area of drain plug. Keep
hairdryer 6 inches from volute and
heat using a side to side motion.
Do not allow volute to become hot
to the touch.

Spa Pump(s) surging

Air being pulled through

Water level low

If spa is equipped with a Skimmer
basket, it should be all the way
down. Door should move freely.
Fill spa to recommended level.

No Water Pressure in
Sections of the Spa

Water not being Diverted
Correctly
Pump not on

Jets not Open

Turn whirlpool jet or valve to divert
water.

Turn on correct pump. Refer to
“‘pump(s) will not start” (above)
Water temperature is 3 or more
above set temperature - wait to
cool.

Turn jets counter-clockwise to
open.

Spa Not Heating (Heat
Icon On)

Pump(s) not on
Closed T Valve open to

allow water to go through it.

Spa maybe in Economy
Mode (lcon/Bulb Not On)
Dirty Filters

Pump Malfunction
Inadequate Water Level
Heater Malfunction

Refer to “pump(s) will not start”
(above)
Lift “T” Valve up so it is all the way

Put spa in Standard mode.

Replace filters with clean or new
filters.

Repair or replace pump.

Add water until it reaches proper
level.

Replace heater.

Circulation Pump Not
Working*

Water Temperature is
3° or more above set
temperature.

Open cover and wait for spa to cool.
If spa is equipped with a blower,
turn it on.
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Designer Series

Problem

Possible Cause

Solution

“‘FLO”

Appears on Control Panel or
‘FLO” flashes and alternates
with Temperature

Pump(s) not running

Water level low
Pump Surging

Dirty or Clogged

*  See “Pump(s) will not Start.”

* Fill spa to correct level.

+ See “Pump Surging” Section
above.

» Check filter installation Filters
Clean filter(s), page 42.

Breaker keeps tripping or will
not Reset

Improperly wired ground

Spa Controller needs
repair

Spa Heater needs
repair

Contact your electrician or
ThermoSpas 800.876.0158.
Customer Care

Spa Leaks

Loose union, drain
valve open
Leaking Barb Fitting

Leaking Glue fitting

Check and tighten all unions,
close drain valve.

Check hose to barb
connection. Clamp hose if
required, call ThermoSpas for
service 800.876.0158.

Call ThermoSpas for service
800.876.0158.
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27.0 Water Chemistry Maintenance

Action Frequency

1. Test and Balance Alkalinity: Bi-Weekly
There are three products needed to test and balance alkalinity:

+ Test Strip: provides a reading on the alkalinity level;

* pH/Alkalinity Up: raises the alkalinity level; and

» pH/Alkalinity Down: lowers the alkalinity level

The acceptable alkalinity level must range between 80-120 ppm (parts per million). Follow the
Adjust Alkalinity/pH.

2. Test and Balance pH Bi-Weekly
There are three products needed to test and balance pH:

» Test Strips: tests the pH level;

* pH/Alkalinity Up: raises the pH level; and

* pH/Alkalinity Down: lowers the pH level

The acceptable pH level must range between 7.2 — 7.8. Do not enter your spa if the pH level is
out of range, or you risk the possibility of skin and eye irritation.

3. Test Total Dissolved Solids (TDS) Monthly
Increases in Total Dissolved Solids will cause your sanitizer to become ineffective. Once TDS
have reached a level of 3000 your water should be changed.

» Use test strips to check level of TDS.

» If the reading is 3,000 ppm or less, the spa requires no maintenance.

4. Treatment of Minerals and Metals Weekly

Control any staining or discoloring of the water caused by minerals. Using these chemicals help

prevent scale from forming on the shell’s surface and/or any corrosion occurring to the heater

element.

« Have your water tested for mineral content, send a water sample to ThermoSpas® Customer
Care Department for a free analysis.

* For weekly water maintenance add 1 oz. of “Stain and Scale.”

5. Treatment of Oils and Organics Weekly
Bathers bring lotions, skin, hair and other organics into spas. Using a natural enzyme that breaks
down and devours oils and other organics that sanitizers cannot destroy is essential to maintaining
clear water. “Natural and Clear” immediately breaks down the organics by converting them into a
gas before they can interfere with the sanitizers’ performance. Because it dissolves the organics
as opposed to coagulating the organics like most other clarifiers used by competitors, “Natural and
Clear” helps rid the acrylic shell of the unsightly “scum line” above the water’s surface.

» For weekly water maintenance add 1/2 oz. of “Natural and Clear.”

6. Excessive Foaming As Required
To correct foaming caused by soap or other residues, use ThermoSpas® “Foam Away.” Make
certain to shake container and disperse only ONE capful where foaming is occurring while water is
circulating. Wait 30 minutes and repeat treatment if foaming continues. It is recommended to clean
your filter within 24 hours of using “Foam Away.” Using too much “Foam Away” will cloud your wa-
ter, taking as much as 24 hours to dissipate. Add only 1 capful at a time and please be patient.

7. Cleaning Biofilm in your spa plumbing lines Drain and Refill
Over time biofilm can accumulate in your spas plumbing lines. Using ThermoSpas® “Jet Line
Cleaner” at least twice a year is recommended to ensure excessive growth of bacteria does not
cause increased use of sanitizers.
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28.0 F.A.Qs

Q:
A:

>0

>0

>0

>0

>0

>0

What happens if | don’t change my ThermoClear cartridge in four months?

The ThermoClear cartridge will start to become ineffective after four months. So, along with
having water that could potentially have a high TDS reading, prohibiting chemicals from
being effective, you will have no method of sanitizing your water leading to potential health
risks.

Which is better to use on a weekly basis with ThermoClear: Spa Activator or Chlorine?

If you are not in any way allergic to Chlorine, then we strongly recommend using it. Chlorine
has a higher ORP rating (oxidation reduction potential) which is the measure of oxidizing
power. The oxidizing power is the ability to burn away organic matter. However, you must
continue to use the Spa Activator each time you use your hot tub.

What happens if | put too much sanitizer into the water?

Too much Spa Activator can cause the skin to itch and potentially produce a skin rash. Over-
shocking your water could potentially damage your hot tub cover, and this would not be
covered in the warranty. Also, an excess of sanitizer might not produce any reading on your
test strip because you have gone beyond its reading capabilities. This has led people to add
more Spa Activator which can make matters worse.

How can | reduce my sanitizer level?
Sanitizer level will drop naturally over time. The best way to lower the sanitizer level is to
simply wait. If necessary, you can drain part of the water and refill to dilute the mixture.

Can | change sanitizers?

The use of ThermoClear and Chlorine can be interchanged in the same spa water. All other
sanitizers require the draining of the hot tub. We recommend the use of ThermoSpas® Jet
Line Cleaner for cleaning out the lines.

Why can’t | use swimming pool chemicals?

A hot tub is dramatically different from a swimming pool because you are working with
water that is both heated and also aerated. The ratios of people are also quite different.
For example, four people in a hot tub is equivalent to 300 people in an average size pool.
The heated water and higher bather load ratio can cause organic contaminants not found
in swimming pools. Because of this, the chemical make-up of swimming pool chemicals is
usually quite different from that of hot tub chemicals. One example is that swimming pool
chemicals are not buffered so they can create havoc on the pH level of your hot tub water.

Why are my pillows/headrests discolored or bleached out?

Headrests that are constantly submerged in spa water that is not properly treated with
chemicals may discolor. However, even if you have been performing your water maintenance
faithfully and correctly, the pillows will still naturally discolor over time. ThermoSpas® does
not provide warranty coverage for bleaching or discoloration of spa pillows.

Why do | need any chemicals if Ozonators work so well?

56



Q:
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Ozone is a powerful oxidizer and there are many contaminants (i.e. ammonia, nitrogen laden
compounds, and bather wastes) that are not controlled by ozone. Proper chemical use is
recommended, take into consideration the how often the hot tub is used and the number of
bathers that use it.

What does O3 mean on the control panel?
O3 simply means if you have an ozonator in your spa it is on. If you do not have one and
wish to order one or to have one installed please call the service department.

NOTE: If O3 doesn’t show up on your control panel this doesn’t mean your ozonator isn’t working
O3 shows up periodically and ozonator works even when light isn’t on.

Q:
A:

| am going away on vacation, should | winterize?

Winterizing your spa while your on vacation is not only smart but it could save you operation
cost. You won'’t have to have someone check it every 24 hours. Also, if the power goes out
or spa freezes this will eliminate any freeze damage which isn’t covered under any warranty.

NOTE: It is the customers responsibility to keep the spa from freezing. With the SmartTub® fea-
ture you will be notified to a possible freeze condition.

Q:
A:

>0

>0

How do | troubleshoot an instant tripping breaker?

The proper way to troubleshoot is first turn GFCI breaker off. Access spa pack and unplug
all components except for light. All water pumps, blowers, and ozonator if spa has one.
Then turn GFCI breaker back on. If breaker does not hold the only components that are still
connected is the heater since heater wires are inside spa pac. If breaker does hold, replug
in components (one at a time) and which ever one is failing will trip breaker when you plug
it in. At this point second, third, forth pump can be left unplugged. Also if blower or ozonator
is causing the problem, they can be left unplugged. Only spas heater and primary pump are
necessary to maintain heat and filter cycle.

| have no pressure to one of my seats, what is the problem?

Try your top side diverter valve to direct water flow to that seat(s). Check the jets for that
seat(s). Your jets may be in the closed position. Most of the jets in your spa have an outer
ring that turns to the left and right. This will open or close the jets.

| have a brand new hot tub and it is leaking. | need a service man right away.

Firstly, there are a few things we will ask you to do. Check that the drain cap in the
equipment bay is screwed on tightly. Describe the area of the spa where the leak seems to
be coming from. Remove one of the skirt panels in that area and check your pump(s) union
connections. If you have a loose union, simply tighten the connection and the leak should
stop. This is a part of your spa start up and is the responsibility of all of our customers to
make sure that this is done.
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29.0 Floor Load Determination

All structures must comply with local and national building requirements. The following recom-
mended measurements represent maximum spans for decking floor joints (shown in feet and
inches), assuming the following:

Modulus > 0.9 MM psi (represents the majority of wood species
Static Load < 10psf (standard for decking design)

Moisture Load < 19.0% (standard for pressure treated wood)
Deflection = L/360 (standard for building codes)

These specifications are subject to change without notice and are for refer-
ence only.
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100 pounds/sq. foot live load
Jc:»int Size ‘ij:;"(tinscli;]aecs' Select Struc- et A
(inches) on center) tural No. 1 No. 2 No. 3
12 7-11 7-9 7-6 6-3
2x6 16 7-2 7-1 6-6 5-5
24 6-4 6-1 5-3 4-5
12 10-5 10-3 9-8 8-0
2x8 16 9-6 9-4 8-4 6-11
24 8-4 7-8 6-10 5-8
12 13-4 12-10 12-6 9-5
2x10 16 12-1 11-1 10-10 8-2
24 10-4 9-1 8-10 6-8
12 16-3 15-4 14-8 11-3
2x12 16 14-9 13-3 12-8 9-9
24 10-4 10-4 10-4 8-0
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30.0 Spa Measurements Chart

Designer Series

These specifications are subject to change without notice and are for refer-

ence only.
Average | \in pad Size
Model Length Width Height Filled Weight )
Manhattan II™ 93 in. 93in. 38 in. 4,683 Ib. 4 in.
Diamond Wave (236.2 cm) (236.2 cm) (96.52 cm) (2,124 kg) (102 mm)
Manhattan II™ 93 in. 93in. 38 in. 4,560 Ib. 4in.
Gold (236.2 cm) (236.2 cm) (96.52 cm) (2,068 kg) (102 mm)
Manhattan [I™ 93 in. 93 in. 38 in. 4,390 Ib. 4 in.
Silver (236.2 cm) (236.2 cm) (96.52 cm) (1,991 kg) (102 mm)
Concord II™ 83in 83in 38.951in 4,148 Ib 4in.
Diamond (210.8 cm) (210.8 cm) (98.9 cm) (1,882 kg) (102 mm)
83in 83 in 38.95in 4,024 Ib. 4 in.
Concord II™ Gold | 519 gcm) | (210.8 cm) (98.9 cm) (1.825 kg) (102 mm)
Concord II™ 83in 83 in 38.95in 3,917 Ib. 4 in.
Silver (210.8 cm) (210.8 cm) (98.9 cm) (1,776 kg) (102 mm)
Concord I[I™ 83in 83 in 38.95in 3,863 Ib. 4 in.
Bronze (210.8 cm) (210.8 cm) (98.9 cm) (1,752 kg) (102 mm)
Park Avenue II™ 93 in. 83 in 38.95in TBD 4in.
Diamond Wave (236.2 cm) (210.8 cm) (98.9 cm) (102 mm)
Park Avenue II™ 93 in. 83 in 38.95in TBD 4in.
Gold (236.2 cm) (210.8 cm) (98.9 cm) (102 mm)
Park Avenue [I™ 93 in. 83 in 38.951in TBD 4 in.
Silver (236.2 cm) (210.8 cm) (98.9 cm) (102 mm)
Aladison, 83 in 66 in 34 in 2,627 Ib 4in.
Diamond Wave (210.8 cm) (167.6 cm) (86.4 cm) (1,192 kg) (102 mm)
Madison 83in 66 in 34 in 2,570 Ib. 4 in.
Avenue™ Gold (210.8 cm) (167.6 cm) (86.4 cm) (1,166 kg) (102 mm)
Madison 83 in 66 in 34 in TBD 4in.
Avenue™ Silver (210.8 cm) (167.6 cm) (86.4 cm) (102 mm)
Madison 83in 66 in 34 in TBD 4in.
Avenue™ Bronze (210.8 cm) (167.6 cm) (86.4 cm) (102 mm)
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el 31.0 Water Capacity Chart
CU Model *Approximate Water Capacity Reference For Chemicals
C ode Average Fill * Use approximate average fill for chemical
O Manhattan 1I™ 430 US gal. measurement
Diamond Wave (1,628 Liters)
425 US gal.
™
‘Bs Manhattan II™ Gold | " 0> 8
@) Manhattan II™ Silver (‘11250983%12)
) Concord II™ 380 US gal
Q_ Diamond (1,438 Liters)
370 US gal
™
8 Concord II™ Gold (1,400 Litors)
. 370 US gal
™
C Concord II™ Silver (1,400 Liters)
365 US gal
™
q) Concord II™ Bronze (1,382 Liters)
= Park Avenue II™ TBD
CU Diamond Wave
Park Avenue II™
; Gold TBD
Park Avenue II™ TBD
Silver
Madison Avenue™ 220 US gal.
Diamond Wave (833 Liters)
Madison Avenue™ 220 US gal.
Gold (833 Liters)
Madison Avenue ™ TBD
Silver
Madison Avenue ™ TBD
Bronze
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